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This guide describes how to install, configure, and usewebMethods SOPERAAdapter. It contains
information for administratorswhomanage awebMethods system, and for application developers
who create services to communicate with the SOPERA infrastructure.

To use this guide effectively, you should:

Understand the basic concepts of SOPERA Adapter and the SOPERA infrastructure.

Be familiar with the set up and operation of webMethods Integration Server.

Have a general idea about how to perform basic tasks with Software AG Designer.

Be familiar with the set up and operation of My webMethods Server.

Know how to create flow services and/or Java services.

Document Conventions

DescriptionConvention

Identifies elements on a screen.Bold

Identifies service names and locations in the format folder.subfolder.service, APIs,
Java classes, methods, properties.

Narrowfont

Identifies:Italic

Variables for which you must supply values specific to your own situation or
environment.
New terms the first time they occur in the text.
References to other documentation sources.

Identifies:Monospace font

Text you must type in.
Messages displayed by the system.
Program code.

Indicates a set of choices from which you must choose one. Type only the
information inside the curly braces. Do not type the { } symbols.

{ }

Separates two mutually exclusive choices in a syntax line. Type one of these
choices. Do not type the | symbol.

|

Indicates one or more options. Type only the information inside the square
brackets. Do not type the [ ] symbols.

[ ]

Indicates that you can type multiple options of the same type. Type only the
information. Do not type the ellipsis (...).

...
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Online Information and Support

Software AG Documentation Website

You can find documentation on the Software AG Documentation website at http://
documentation.softwareag.com.

Software AG Empower Product Support Website

If you do not yet have an account for Empower, send an email to empower@softwareag.comwith
your name, company, and company email address and request an account.

Once you have an account, you can open Support Incidents online via the eService section of
Empower at https://empower.softwareag.com/.

You can find product information on the Software AG Empower Product Support website at
https://empower.softwareag.com.

To submit feature/enhancement requests, get information about product availability, and download
products, go to Products.

To get information about fixes and to read early warnings, technical papers, and knowledge base
articles, go to the Knowledge Center.

If you have any questions, you can find a local or toll-free number for your country in our Global
Support Contact Directory at https://empower.softwareag.com/public_directory.aspx and give us
a call.

Software AG TECHcommunity

You can finddocumentation and other technical information on the SoftwareAGTECHcommunity
website at http://techcommunity.softwareag.com. You can:

Access product documentation, if you have TECHcommunity credentials. If you do not, you
will need to register and specify "Documentation" as an area of interest.

Access articles, code samples, demos, and tutorials.

Use the online discussion forums, moderated by Software AG professionals, to ask questions,
discuss best practices, and learn how other customers are using Software AG technology.

Link to external websites that discuss open standards and web technology.

Data Protection

SoftwareAGproducts provide functionalitywith respect to processing of personal data according
to the EU General Data Protection Regulation (GDPR). Where applicable, appropriate steps are
documented in the respective administration documentation.
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About the Adapter

webMethods SOPERA Adapter is a webMethods Integration Server adapter that allows you to
exchange data with the SOPERA infrastructure. The adapter provides seamless and real-time
communications to and from the SOPERA ESB.

UsingwebMethods SOPERAAdapter, Integration Server clients can invoke SOPERA services and
allow the SOPERA infrastructure to call the Integration Server services. For example, you can use
SOPERAAdapter in a flow that receives data from the SOPERA infrastructure and then sends the
processed data back to the SOPERA infrastructure.

SOPERA Adapter supports the request-response, one-way, notification, and request-callback
SOPERA communication styles. For more information about SOPERA communication styles, see
“Communication Styles Support” on page 15.

Architecture and Components

webMethods SOPERAAdapter provides a set of user interfaces, services, and templates that enable
you to create integrations with the SOPERA infrastructure. The adapter is provided as a single
package that must be installed on Integration Server. For detailed installation instructions, see
“Installing webMethods SOPERA Adapter ” on page 21.

The following diagram shows at a high level how the adapter components connect to the SOPERA
infrastructure:

webMethods Integration Server

webMethods SOPERA Adapter is installed and runs on webMethods Integration Server.

WmART Package

The WmART package provides a common framework for webMethods version 6.0 and later
adapters to use the Integration Server's functionality, making Integration Server the run-time
environment for SOPERA Adapter. The WmART package is installed with Integration Server

10 webMethods SOPERA Adapter Installation and User’s Guide 8.0

1 Overview of webMethods SOPERA Adapter



and provides logging, transaction management, and error handling for the adapter and its
connections, services, and notifications.

SOPERA Adapter

webMethods SOPERA Adapter is delivered as a single package called WmSoperaAdapter .
The adapter installation includes templates from which all adapter connections, adapter
services, adapter listeners, and adapter notifications can be created.

SOPERA Participant

A SOPERA Participant is a running business application that consumes or provides services.
SOPERA Adapter enables the communication between the SOPERA infrastructure and the
webMethods product suite by processing requests from SOPERA participants and sending
requests to those participants. SOPERA Adapter uses the following components to interact
with the SOPERA infrastructure:

AdminTool

The SOPERA AdminTool is the utility used to accomplish the main administration tasks
required for SOPERA Participants, such as looking up and registering services. You must
specify the path to the SOPERA AdminTool in the SOPERA Adapter configuration file
after you install the adapter.

Service Backbone

The SOPERA Service Backbone (SBB) library interfaces with the SOPERA infrastructure.
To access the SOPERA infrastructure, youmust specify the path to the SOPERAParticipant
SBB library when you configure SOPERA Adapter connections.

SOPERA Infrastructure

The SOPERA infrastructure consists of SOPERA Technical Service Providers, the SOPERA
Service Registry, a directory server, and a messaging system. webMethods SOPERA Adapter
communicates with the SOPERA infrastructure to invoke SOPERA services or to handle
requests from the SOPERA infrastructure to execute services on Integration Server.

Java Runtime

The execution environment for Integration Server and the SOPERA Participant interacting
with webMethods SOPERA Adapter.

My webMethods Server is a run-time container for functions made available by webMethods
applications. The user interface inwhich you perform these functions is calledMywebMethods.
You can access Integration Server using the My webMethods user interface.

My webMethods Server Login Portlets

The My webMethods Server Login Portlet allows logging on to My webMethods Server as a
SOPERA user.
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Adapter Package Management

webMethods SOPERA Adapter is provided as a package called WmSoperaAdapter that you
manage like any package on Integration Server.

There are several considerations regarding how you set up and effectively manage your packages
on Integration Server, such as those described in the following list:

Configure user-defined packages for your adapter connections and adapter services. Formore
information, see “Managing the Adapter Package” on page 32.

Understand how package dependencies work so you make the best decisions regarding how
youmanage your adapter services and adapter notifications. Formore information, see “Package
Dependency Requirements and Guidelines” on page 32.

Control which development groups have access to which adapter services and adapter
notifications. For more information, see “Controlling Group Access” on page 36.

Enable and disable packages. Formore information, see “Enabling andDisabling Packages” on
page 33.

Load, reload, and unload packages. For more information, see “Loading, Reloading, and
Unloading Packages” on page 34.

Adapter Connections

An adapter connection enables Integration Server to connect to the SOPERA infrastructure at run
time. You must configure an adapter connection before you can create adapter services or
notifications. You create one ormore connections at design time to use in integrations. The number
of connections you create depends on your integration needs. You configure connections using
Integration Server Administrator. You must have webMethods administrator privileges to access
the administrative screens of the adapter. For instructions on configuring, viewing, editing,
enabling, and disabling SOPERA Adapter connections, see “Adapter Connections” on page 37.
For information about setting user privileges, see thewebMethods Integration Server Administrator’s
Guide for your release. For a list of tasks that you must do before you can create your connections,
see “Before Configuring or Managing Adapter Connections” on page 38.

Connection Pools
Integration Server includes a connectionmanagement service that dynamicallymanages connections
and connection pools based on configuration settings that you specify for the connection. By
default, connection pooling is enabled for all adapter connections.

Run-Time Behavior of Connection Pools

In SOPERA Adapter no physical connections are created or managed, but each connection pool
creates a new SBB instance and uses that instance for all operations involving interaction with the
SOPERA infrastructure.
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Each SBB instance created is identified uniquelywith a commonAppID, but a different InstanceID
that maps to the connection pool name.

It is recommended to restrict the number of connection pools to preserve possibly scarce resources
such as memory space or network connections.

For information about configuring connections, see “Adapter Connections” on page 37.

Built-in Services for Connections
Integration Server provides built-in services that enable you to programmatically control
connections. You can use the services to enable and disable a connection, and to return usage
statistics and the current state (Enabled or Disabled) and error status for a connection. These
services are located in the WmART package, in the pub.art.connection folder.

For complete information about the services in theWmART folder, see the webMethods Integration
Server Built-In Services Reference for your release.

Changing the Connection Associated with an Adapter Service
at Design Time
Integration Server provides a built-in service that you can use at design time to change the
connection associated with an adapter service. This built-in service is named
pub.art.service:setAdapterServiceNodeConnection. Using this service, you can change the specific connection
associated with an adapter service at design time so that you do not need to recreate adapter
services.

Note:
This built-in service can be run at design time only; do not use it within an Integration Server
flow or Java service. You must run this service directly from Designer by selecting the service
in Designer and running it.

For details about the setAdapterServiceNodeConnection service, see the webMethods Integration Server
Built-In Services Reference for your release.

Adapter Services

Adapter services enable you to connect to the adapter’s resource (that is the SOPERA infrastructure)
and initiate an operation on the resource from Integration Server. Every invocation of a SOPERA
service by other Integration Server services or Integration Server clients goes through an adapter
service.

You call adapter services from flow services or Java services to interact with the SOPERA
infrastructure. Integration Server uses adapter connections that you defined earlier to execute the
adapter services.

Adapter services are based on templates providedwith SOPERAAdapter. Each template represents
a specific technique for doing work on a resource. An adapter service template contains all the
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code necessary for interacting with the resource but without the data specifications. You provide
these specifications when you configure a new adapter service.

Configuring a new service from an adapter service template is straightforward. Using Software
AG Designer, you assign the service a default adapter connection.

After you select the connection for the adapter service, you select the adapter service template
and supply the data specifications, including the mapping of data types from the adapter to or
fromyour adapter resource. You use SoftwareAGDesigner to configure the adapter service. Some
familiaritywith using SoftwareAGDesigner is required. Formore information, see thewebMethods
Service Development Help.

SOPERA Adapter provides the following adapter service templates:

DescriptionAdapter Service Template

Invokes a generic SOPERA service.SOPERA Generic Consumer

Invokes a SOPERA notification service.SOPERA Notification Provider

Sends a callback response.SOPERA Callback Sender Provider

Adapter Listeners and Listener Notifications

When the interaction is initiated by the adapter resource (for example, SOPERA calling an
Integration Server service), SOPERA Adapter uses adapter listeners and notifications.

By creating an adapter notification, an Integration Server service is registered as a provider in the
SOPERA Service Registry or a handler is created to consume messages from the SOPERA
infrastructure. When a notification is enabled, the provider is active and SOPERA Adapter can
handle any requests by SOPERA participants.

You use Integration Server Administrator to configure and manage adapter notifications. For
detailed instructions on how to configure listener notifications, see “Listener Notifications” on
page 68.

SOPERAAdapter provides the following adapter notification templates that you configure using
Software AG Designer:

DescriptionAdapter Notification Template

Publishes an IS service as a SOPERA service.SOPERA Generic Provider

Consumes SOPERA notification.SOPERA Notification Consumer

Notifies for a callback response.SOPERA Callback Consumer

Provides a handler for Request-callback.SOPERA Request-callback Provider

For detailed instructions on how to configure adapter notifications using Designer, see “Adapter
Notifications” on page 61.
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Communication Styles Support

SOPERA Adapter enables the communication between the SOPERA infrastructure and the
webMethods product suite by processing requests fromSOPERAparticipants and sending requests
to those participants. SOPERAparticipants are business applications that consume services (service
consumers) or provide services (service providers). You canuse one of the following communication
styles of SOPERA services as part of calling the SOPERA services from your adapter services:

Request-response. The service consumer sends a request message to the service provider. The
provider processes the request and returns a response message to the consumer. The
request-response operation can be:

Blocking. The service blocks the service invocation until a response message is sent to the
consumer.

Non-blocking. The service invocation returns before the response has been received.

One-way. The service consumer sends a request message to the service provider, but does not
expect any response.

Notification.The service provider sends amessage tomultiple service consumers transparently.
In effect this communication style implements a publish-subscribe communication. The service
provider “publishes” a message that is received by any consumer that has subscribed to it.

Note:SOPERA notification should not be confused with an adapter notification. An adapter
notification is an element on Integration Server that receives data from the backend system.
SOPERA notification is a communication style for a publish-subscribe type of message
exchange.

Request-callback.The request-callback communication style is similar to the request-response
style in that the service consumer sends amessage to the provider and then the provider sends
back a message. The difference is that the sending of the request and callback messages is
implemented as independent one-way operations that are correlated by the SOPERA library.
With this style, the callback can be received at any future point of time after the request has
been sent andmight actually go to a different physical system than that fromwhich the request
originated. In a similar way, the provider does not have to send the callback immediately and
might delegate the sending of the callback to a different component.

Creating Service Consumers
SOPERAAdapter provides adapter service and notification templates that you use to create service
consumers for all supported communication styles. The following table lists the adapter templates
that you use to create a service consumer for each communication style:

Template TypeAdapter Service/Notification
Template Name

Communication Style

Adapter serviceSOPERA Generic ConsumerRequest-response
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Template TypeAdapter Service/Notification
Template Name

Communication Style

Adapter serviceSOPERA Generic ConsumerOne-way

Adapter notificationSOPERA Notification ConsumerNotification

Adapter serviceRequest-callback SOPERA Generic Consumer

Adapter notificationSOPERA Callback Consumer

Note:
Used only when the Send
request only field in the
SOPERA Generic Consumer
template is selected.

With the request-callback communication style, you create a service consumer in one of the
following ways:

Configure the SOPERA Generic Consumer adapter service by selecting a specific SOPERA
service and the request-callback operation as the operation that the adapter servicewill provide.
This is similar to a non-blocking request-response style.

Create a Request-callback service consumer in two steps:

Create the SOPERA Generic Consumer adapter service that submits the request.

Create the SOPERA Generic Consumer adapter notification that receives the callback.

Formore information about creating service consumers using the adapter templates, see “Adapter
Services” on page 45 and “Adapter Notifications” on page 61.

Creating Service Providers
SOPERAAdapter supports creating service providers for the supported communication styles in
the following ways:

Use an existing IS service and SOPERA Adapter generates internally the service description
(SDX) from the signature of that service.

Select an existing SDX and create an empty IS service with a signature matching the signature
of the existing SDX. This approach is known as the SDX-first approach.

With the request-callback communication style you create adapter service providers in the following
ways:

Create an adapter notification that calls an IS service and returns the output of that service as
the callback.

Create an adapter service provider in two steps:
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Create an adapter notification that receives the request and publishes a document.

Create an adapter service that is invoked separately to return the callback.

SOPERAAdapter provides adapter service and notification templates that youuse to create adapter
service providers for all supported communication styles. The following table lists the adapter
templates that you use to create an adapter service provider for each communication style:

Template TypeAdapter Service/Notification
Template Name

Communication Style

Adapter notificationSOPERA Generic ProviderRequest-response

Adapter notificationSOPERA Generic ProviderOne-way

Adapter serviceSOPERA Notification ProviderNotification

Adapter notificationRequest-callback SOPERA Generic Provider

or Adapter service

Adapter notificationSOPERA Request-callback
provider

SOPERACallbackSenderProvider

For more information about creating service providers using the adapter templates, see “Adapter
Services” on page 45 and “Adapter Notifications” on page 61.

SOPERA User Authentication

SOPERA Adapter authenticates a SOPERA user against the SOPERA infrastructure using JAAS
login modules for:

Logging on to Integration Server Administrator

Logging on to My webMethods Server

Sending outgoing SOPERA calls

Receiving incoming SOPERA calls

To enable authentication for Integration Server Administrator, incoming, and outgoing SOPERA
calls, you must configure the Integration Server Login Module (IS Login Module).

To enable authentication for My webMethods Server, you need to configure the My webMethods
Server Login Module (MWS Login Module).

For more information about JAAS login modules, see the webMethods Integration Server
Administrator’s Guide for your release.

For both the IS Login Module and the MWS Login Module, the functionality depends on central
usermanagement being properly configured beforehand. For information about how to configure
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these login modules, see “Configure the IS Login Module” on page 25 and “Configure the MWS
Login Module” on page 27.

After you configure the IS LoginModule and theMWS LoginModule, they authenticate SOPERA
users against the SOPERA infrastructure and place them in a group called SOPUsers. You assign
access control lists (ACLs) to the SOPUsers group as required to access the functionality that you
want to use.

For outgoing SOPERAcalls, the adapter propagates the session information containing the SOPERA
SAML token to the SOPERA infrastructure. In this way if the provider or consumer policy has
been configured for authentication and authorization, the infrastructure validates the token before
the service is invoked. The SOPERA call is performed by the same user that invokes the adapter
service on Integration Server.

For incoming SOPERA calls, authentication happens on two levels. First, the infrastructure
authenticates and authorizes the user based on the SAML token that has been sent if the provider
and consumer have the required security configuration. Then the user is authenticated in Integration
Server when incoming call authentication has been configured. The adapter validates the SAML
token it receives and creates a session for the respective user on Integration Server. The IS service
configured as a provider is invoked with the user credentials.

For more information on SOPERA authentication and authorization, see the SOPERA
documentation.

Using Version Control Systems to Manage Adapter Elements

The adapter supports the VersionControl System (VCS) Integration feature provided byDesigner.
When you enable the feature in Integration Server, you can check adapter packages or elements
into and out of your version control system from Designer. For more information about the VCS
Integration feature, see the Configuring the VCS Integration Feature.

Beginning with Integration Server 8.2 SP3, the adapter supports the local service development
feature in Designer. This feature extends the functionality of the VCS Integration feature to check
package elements and their supporting files into and out of a VCS directly from Designer. For
more information about local service development and how it compares to the VCS Integration
feature, see the webMethods Service Development Help.

Optimize Infrastructure Data Collector Support for the Adapter

Optimize Infrastructure Data Collector monitors the system and operational data associated with
webMethods run-time components such as Integration Servers, Broker Servers, Brokers, and
adapters, and reports the status of these components on Optimize for Infrastructure or other
external tools. When you start monitoring an Integration Server, Infrastructure Data Collector
automatically starts monitoring all ART-based adapters that are installed on Integration Server.
For information about monitored key performance indicators (KPIs) collected for the monitored
adapter components, see the webMethods Optimize User’s Guide.
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Viewing the Adapter’s Update Level

You can view the list of updates that have been applied to the adapter. The list of updates appears
in the Updates field on the adapter's About page in Integration Server Administrator.

Controlling Pagination

When using the adapter on Integration Server 9.0 and later, you can control the number of items
that are displayed on the adapter Connections screen. By default, 10 items are displayed per page.
Click Next and Previous to move through the pages, or click a page number to go directly to a
page. To change the number of items displayed per page, set the watt.art.page.size property
and specify a different number of items.

To set the number of items per page

1. From Integration Server Administrator, click Settings > Extended.

2. Click Edit Extended Settings. In the Extended Settings editor, add or update the
watt.art.page.size property to specify the preferred number of items to display per page.
For example, to display 50 items per page, specify: watt.art.page.size=50

3. Click Save Changes. The property appears in the Extended Settings list.

Formore information aboutworkingwith extended configuration settings, see thewebMethods
Integration Server Administrator’s Guide for your release.
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Overview

This chapter explains how to use the SoftwareAG Installerwizard to install, upgrade, and uninstall
webMethods SOPERA Adapter 8.0. For complete information about other installation methods
or installing other webMethods products, see the Installing webMethods Products On Premises for
your release.

This webMethods SOPERA Adapter Installation and User’s Guide refers to the main installation
directory as Software AG_directory .

Requirements

For a list of the operating systems and products supported by SOPERA Adapter, see webMethods
Adapters SystemRequirements , available in thewebMethods area of the SoftwareAGDocumentation
Website.

Installing SOPERA Adapter

The instructions in this section are meant to be used with the more complete instructions in the
Installing webMethods Products On Premises for your release.

Important:
You must install the SOPERA ESB infrastructure before you install SOPERA Adapter.

To install SOPERA Adapter 8.0

1. Download the Software AG Installer from the Empower Product Support website.

2. If you are installing the adapter on an existing Integration Server, shut down Integration Server.

3. Start the Software AG Installer wizard.

Choose the webMethods release that includes the Integration Server on which to install the
adapter. For example, if you want to install the adapter on Integration Server 9.5, choose the
9.5 release.

If you are installing on an existing Integration Server, specify the webMethods installation
directory that contains the host Integration Server. If you are installing both the host Integration
Server and the adapter, specify the installation directory to use. The Installer will install the
adapter in the Integration Server_directory \packages directory.

4. In the product selection list, select Adapters > webMethods SOPERA Adapter 8.0.

5. To install documentation for webMethods SOPERA Adapter, on the Documentation panel in
Installer, select Adapter Readmes and Documentation. Alternatively, you can download
the adapter documentation at a later time from the Software AG Documentation Website
(http://documentation.softwareag.com/).
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6. After the Installer completes the adapter installation, close the Installer.

7. Copy the following files from the SOPERA SBB_directory\lib directory into the
Integration Server_directory \packages\ WmSoperaAdapter \code\jars directory:

jax-qname-namespace.jar

sbb-factory-impl.jar

sbb-papi.jar

8. Copy the following files from the SOPERA infrastructure into the Integration Server_directory
\packages\ WmSoperaAdapter \code\jars\static directory:

login.jar

sbb-se-core.jar

9. Copy the following files from the SOPERA AdminTool_directory\lib directory into the
Integration Server_directory \packages\ WmSoperaAdapter \code\jars directory:

jaxmeapi-0.5.1.jar

jaxmexs-0.5.1.jar

jaxme2-0.5.1.jar

jaxme2-rt-0.5.1.jar

privilegemanagement-jaxb.jar

privilegemanagement-proxy.jar

sbb-admin-tool.jar

sbb-configrepos-scopepath.jar

sbb-instance-proxy-plugin.jar

sbb-proxy-util.jar

sbb-toolsuite-service-utilities.jar

sbb-toolsuite-common.jar

userAccountManagement-proxy.jar

userAccountManagement-jaxb.jar

10. Complete the installation as described in “Completing the Installation” on page 23.

11. Start the host Integration Server.

Completing the Installation

To complete the installation, you must perform the following tasks before start up.
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Set SOPERA Specific Properties in the SOPERA Adapter
Configuration File

To set the properties in the sopera.config file

1. Navigate to the Integration Server_directory \packages\ WmSoperaAdapter \config directory.

2. Open the sopera.config file in a text editor.

3. Specify the properties as described in the following table:

Description/ActionProperty

Required. Set to the home directory of the
SOPERA SBB Library installation on the local

org.sopware.sbb.home

system. For example,
C:\SOPERA\ServiceBackbone

Set to the homedirectory of the SOPERAAdmin
Tool location on the local system. This parameter
is required. For example, C:\SOPERA\AdminTool

org.sopware.admintool.home

Optional. Set the HTTP inbound transport for
the SOPERA SBB Library. Valid values are:

org.sopware.transport.http.enable

trueEnablesHTTP. This is the default value.

false Disables HTTP.

Optional. Set the HTTP inbound port for the
SBB Library running on the Java VM. If you do

org.sopware.transport.http.port

not specify a value, the adapter will throw an
error when you attempt to enable the adapter
notification.

Optional. Set the HTTPS inbound transport for
the SOPERA SBB Library. Valid values are:

org.sopware.transport.https.enable

true Enables HTTPS.

false Disables HTTPS. This is the default
value.

Optional. Set the HTTPS inbound port for the
SOPERA SBB Library running on the Java VM.

org.sopware.transport.https.port

Optional. Set the file name of the keystore used
by the SOPERA SBB Library for enabling the
HTTPS transport.

org.sopware.transport.https.keystore
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Description/ActionProperty

Optional. The password for accessing the
keystore used by the SBB Library for enabling
the HTTPS transport.

org.sopware.transport.https.password

Optional. Set client authentication for theHTTP
or HTTPS inbound transport. Valid values are:

org.sopware.transport.https.clientauth

true Enables client authentication.

false Disables client authentication. This is
the default value.

Note:
You can remove or comment the optional properties in the sopera.config file. For details
about these system properties, see the SOPERA configuration reference guide.

4. Save and close the file.

Configure the IS Login Module
You use the IS Login Module to authenticate a SOPERA user against a SOPERA infrastructure.

The IS LoginModule is a JAAS loginmodule that is automatically installed as part of the SOPERA
Adapter installation. By default, the IS Login Module is not enabled. For more information about
SOPERA user authentication, see “ SOPERA User Authentication” on page 17.

To configure the IS Login Module

1. Configure central user management as described in the webMethods Integration Server
Administrator’s Guide for your release.

Central user management is required to store and manage information about SOPERA users.

2. Navigate to the Integration Server_directory \config directory.

3. Open the is_jaas.cnf file in a text editor.

4. Edit the file as follows:

a. Add the following code in the IS_Transport section to include the WmLoginModuleIS
loginmodule. Set the authenticationTSPEndpoint parameter to point to your token service:

IS_Transport
{

com.softwareag.security.login.webmethods.WmLoginModuleIS
sufficient

create_user_principal=true
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auth-type=auth-id-password
authenticationTSPEndpoint=

"http://SOPERAInfrastructureServer:18080/TokenService/services/Trust"
soapRequestTemplateFile="config/sts-request.template";

com.wm.app.b2b.server.auth.jaas.X509LoginModule requisite;
com.wm.app.b2b.server.auth.jaas.BasicLoginModule requisite;

};

where SOPERAInfrastructure Server is the hostname of your actual SOPERA infrastructure
server, for example: "http://localhost:18080/TokenService/services/Trust"

b. Configure incoming SOPERA call authentication. SOPERA Adapter verifies the
authentication information it receives from an incoming SOPERA call and creates an
Integration Server session for it. This configuration is required onlywhen SOPERAAdapter
invokes an Integration Server service that does not have the anonymousACL for execution.
To enable incoming call authentication, add the following section:

Note:
The values for verificationKeystore and verificationKeystorePwd parameters will depend
on your environment.

sopware.auth-token-checking {
org.sopware.security.login.webmethods.WMLoginModule REQUIRED
auth-type=auth-token-checking
expiryClearance="525600"
verificationKeystore="/Users/root/keystore.jks"
verificationKeystorePwd="atleast8"
verificationCertAlias="client"
verifyTrustChain="false"
cacheCleanupInterval="5"
samlAttributeForPrincipalName="pxpUid";

};

5. Save and close the is_jaas.cnf file.

6. Copy the sts-request.template file from the Integration Server_directory \packages\
WmSoperaAdapter \config directory into the Integration Server_directory \config directory.

7. Restart Integration Server for the changes to take effect.

8. Log on to Integration Server Administrator as Administrator and go to Security > Access
Control Lists.

9. Add the group of SOPERA users named SOPUsers to the ACL that you require.

For example, if you want to log on as Administrator in Integration Server Administrator with
a SOPERA user, you can add the SOPUsers group to the Allowed ACL list as described in the
webMethods Integration Server Administrator’s Guide for your release.
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Configure the MWS Login Module
When you use My webMethods Server and you want to log on to My webMethods Server using
a SOPERAuser, youmust configure theMWSLoginModule. TheMywebMethods Server portlets
that you must deploy are packaged with SOPERA Adapter and are located in the
Integration Server_directory \packages\WmSoperaAdapter\portlets directory.

Note:
Configuring the MWS Login Module is required onlywhen you want to use My webMethods
interfaces to access Integration Server. If you are using only Integration Server Administrator,
configure only the IS LoginModule as described on “Configure the IS LoginModule” on page 25.

To configure the MWS Login Module

1. Configure central user management as described in the webMethods Integration Server
Administrator’s Guide for your release.

Central user management is required to store and manage information about SOPERA users.

2. Copy the is_jaas.cnf file from the Integration Server_directory \config directory into the
My webMethods Server_directory \default\config directory, and then rename the file to
sopera_login.properties.

Important:
If you want to use onlyMWS LoginModule and you have not configured IS LoginModule,
you must edit the is_jaas.cnf file as described in step 4a in “Configure the IS Login
Module” on page 25.

3. Copy the sts-request.template file from the Integration Server_directory \packages\
WmSoperaAdapter \config directory into theMywebMethods Server_directory\default\config
directory.

4. Install both portlets, wm_sopera_auth.pdp andwm_sopera_login.pdp, usingMywebMethods:

a. Log on toMy webMethods Server as system administrator.

b. Navigate to Administration > Configuration > Install Administration.

c. Click Install New Component.

d. Specify the Integration Server_directory \packages\WmSoperaAdapter \portlets directory
as the location for the portlets.

e. Click Next.

f. Click Install.
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If the portlets are installed successfully, you will get a confirmationmessage verifying that the
install succeeded. If the installation fails, check your log files to troubleshoot the installation
failure. Formore information about how to install portlets, see theAdministeringMywebMethods
Server for your release.

5. Copy the login.jar file and the login-webmethods.jar file from the Integration Server_directory
\packages\WmSoperaAdapter \code\jars\static directory into the following location in the
wm_sopera_auth portlet installation:My webMethods Server_directory
\server\default\system\wm_sopera_auth\lib

6. Create a custom login page as follows. With this custom login page, you can log on as both a
SOPERA user and a normal My webMethods Server user. For detailed instructions for each
of these steps, see the Administering My webMethods Server for your release.

a. Log on to My webMethods Server as system administrator.

b. Go to the Public Folders and add a new page from the Tools menu.

c. Add the SOPERA login portlet from Portlets > System to the new page.

d. Ensure that the authentication scheme for your custom login page and the SOPERA login
portlet is Anonymous.

e. Create a new login rule that invokes the new custom login page. Ensure that this rule is
the first to be executed.

Upgrading from SOPERA Adapter 7.1

To upgrade and migrate from SOPERA Adapter 7.1 to SOPERA Adapter 8.0

1. Back up your existing SOPERA Adapter 7.1 installation and all custom packages.

2. In Integration Server Administrator, go to Packages > Management and locate the
WmSoperaAdapter package.

3. To uninstall SOPERA Adapter 7.1, select Safe Delete. The existing installation is deleted and
preserved for reference.

4. Install SOPERA Adapter 8.0 as described in “Installing SOPERA Adapter ” on page 22.

5. Complete the installation as described in “Completing the Installation” on page 23.

Uninstalling SOPERA Adapter

The instructions in this section are meant to be used with the uninstallation instructions in the
Installing webMethods Products On Premises for your release.
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To uninstall SOPERA Adapter 8.0

1. Shut down the host Integration Server. You do not need to shut down any other webMethods
products or applications that are running on your machine.

2. Start the SoftwareAGUninstaller, selecting thewebMethods installation directory that contains
the host Integration Server. In the product selection list, select Adapters > webMethods
SOPERA Adapter 8.0.

3. After the Uninstaller completes, restart the host Integration Server.

4. The Uninstaller removes all SOPERA Adapter 8.0-related files that were installed. However,
it does not delete files created after you installed the adapter (for example, jar files copied into
Integration Server_directory\packages\WmSoperaAdapter \ code\jars\static\ or configuration
files), nor does it delete the adapter directory structure. You can go to the
Integration Server_directory \packages directory and delete the WmSoperaAdapter directory.

5. The Uninstaller does not delete any user-defined SOPERA Adapter 8.0 components such as
connections, adapter services, or adapter notifications. Because these components will not
work without the adapter, delete them manually, either at the file system level or using
Designer. For instructions, see the webMethods Service Development Help.

webMethods SOPERA Adapter Installation and User’s Guide 8.0 29

2 Installing webMethods SOPERA Adapter



30 webMethods SOPERA Adapter Installation and User’s Guide 8.0

2 Installing webMethods SOPERA Adapter



3 Package Management

■   Managing the Adapter Package ..................................................................................... 32

■   Package Dependency Requirements and Guidelines .................................................... 32

■   Enabling and Disabling Packages .................................................................................. 33

■   Loading, Reloading, and Unloading Packages ............................................................... 34

■   Importing and Exporting Packages ................................................................................ 35

■   Setting Package Dependencies ..................................................................................... 35

■   Controlling Group Access ............................................................................................... 36

webMethods SOPERA Adapter Installation and User’s Guide 8.0 31



Managing the Adapter Package

SOPERA Adapter is provided as a package called WmSoperaAdapter . You manage the
WmSoperaAdapter package as you would manage any package on Integration Server.

When you create connections, adapter services, and adapter notifications, define them in
user-defined packages rather than in the WmSoperaAdapter package. Doing so will allow you to
manage the package more easily.

As you create user-defined packages in which to store connections, adapter services, and adapter
notifications, use the package management functionality provided in Designer and set the
user-defined packages to have a dependency on theWmSoperaAdapter package. That way, when
the WmSoperaAdapter package loads or reloads, the user-defined packages load automatically.
See the following diagram:

Package management tasks include:

Setting package dependencies

Enabling and disabling packages

Loading, reloading, and unloading packages

Importing and exporting packages

Controlling group access

Package Dependency Requirements and Guidelines

This section contains a list of dependency requirements and guidelines for user-defined packages.
For instructions for setting package dependencies, see the webMethods Service Development Help.

By default, the WmSoperaAdapter package has a dependency on the WmART package. Do
not change this dependency.
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A user-defined package must have a dependency on its associated adapter package,
WmSoperaAdapter .

Package dependencies ensure that at startup Integration Server automatically loads or reloads
all packages in the proper order: theWmART package first, the adapter package next, and the
user-defined package(s) last. TheWmARTpackage is automatically installedwhen you install
Integration Server. You should not need to manually reload the WmART package.

If the connections and adapter services of an adapter are defined in different packages, then:

A package that contains the connection(s)must have a dependency on the adapter package,
WmSoperaAdapter .

Packages that contain adapter services must have a dependency on their associated
connection package.

Keep connections for different adapters in separate packages so that you do not create
interdependencies between adapters. If a package contains connections for two different
adapters, and you reload one of the adapter packages, the connections for both adapters will
reload automatically.

Integration Server will not allow you to enable a package if it has a dependency on another
package that is disabled. That is, before you can enable your package, you must enable all
packages on which your package depends. For information about enabling packages, see
“Enabling and Disabling Packages” on page 33.

Integration Server will allow you to disable a package even if another package that is enabled
has a dependency on it. Therefore, youmust manually disable any user-defined packages that
have a dependency on the adapter package before you disable the adapter package.

You can name connections, adapter services, and notifications the same name provided that
they are in different folders and packages.

Enabling and Disabling Packages

All packages are automatically enabled by default. When youwant to temporarily prohibit access
to the elements in a package, disable the package.When you disable a package, the server unloads
all of its elements from memory. Disabling a package prevents Integration Server from loading
that package at startup. A disabled package will remain disabled until you explicitly enable it
using Integration Server Administrator.

Enabling a Package

To enable a package

1. In Integration Server Administrator: Packages > Management.

2. Click No in the Enabled column. The server displays Yes in the Enabled column.
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Note:
Enabling an adapter packagewill not cause its associated user-defined package(s) to be reloaded.
For information about reloadingpackages, see “Loading, Reloading, andUnloadingPackages” on
page 34.

Important:
Before youmanually enable a user-defined package, youmust first enable its associated adapter
package ( WmSoperaAdapter ). Similarly, if your adapter has multiple user-defined packages,
and you want to disable some of them, disable the adapter package first. Otherwise, errors will
be issued when you try to access the remaining enabled user-defined packages.

Disabling a Package

To disable a package

1. In Integration Server Administrator: Packages > Management.

2. Click Yes in the Enabled column for the package that you want to disable. The server issues
a prompt to verify that you want to disable the package. Click OK to disable the package.
When the package is disabled, the server displays No in the Enabled column.

A disabled adapter will:

Remain disabled until you explicitly enable it using Integration Server Administrator.

Not be listed in Designer.

Loading, Reloading, and Unloading Packages

As described in “Package Dependency Requirements and Guidelines” on page 32, if user-defined
packages are properly configuredwith a dependency on the adapter package, at startup Integration
Server automatically loads or reloads all packages in the proper order: theWmART package first,
the adapter package next, and the node package(s) last. You should not need to manually reload
the WmART package.

Reloading Packages Manually
Reloading a user-defined package will not cause its associated adapter package to be reloaded.
You can reload adapter packages and user-defined packages from either Integration Server
Administrator (by clicking the Reload icon on the Management window) or from Designer (by
right-clicking the package and selecting the Reload Package option from the menu).
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Unloading Packages
At shutdown, Integration Server unloads packages in the reverse order in which it loaded them:
it unloads the node package(s) first, the adapter package next, and the WmART package last
(assuming the dependencies are correct).

Importing and Exporting Packages

You import and export packages using Designer. Exporting allows you to export the package to
a .zip file and save it to your hard drive. The .zip file can then be imported for use by another
package.

Important:
Do not rename packages you export; the rename function is comparable to moving a package,
andwhen you import the renamedpackage, you lose any triggers, connections, and notifications
associated with this package.

For details about importing and exporting packages, see thewebMethods Service Development Help.

Setting Package Dependencies

You set package dependencies if a given package needs services in another package to load before
it can load. For example, any packages you create for SOPERA Adapter services should identify
the adapter’s package (WmSoperaAdapter ) as a package dependency because they require services
in WmSoperaAdapter to load first. Use the following guidelines:

Set package dependencies from the adapter service package to the package containing the
connection if you configure a connection in one package and the adapter services in another
package. That is, the package that contains the connection should load before the adapter
service package.

When you set this package dependency, it ensures that if someone disables the connection
package and then re-enables it, the adapter services will reload correctly.

If both the connection and adapter services are in the same package, set this package to have
a dependency on the WmSoperaAdapter package.

In general, packages containing connections should have a dependency set to the adapter
package itself. That is, the adapter service package should depend on the adapter connection
package, which should depend on the adapter package. Similarly, if the adapter services are
in the same package as the connections, the only dependency that you need to set is between
the adapter connection package and the adapter package.

Formore information about setting package dependencies, see thewebMethods ServiceDevelopment
Help.
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Controlling Group Access

To control which development group has access to which adapter services, use access control lists
(ACLs). You can use ACLs to prevent one development group from inadvertently updating the
work of another group, or to allow or deny access to services that are restricted to one group but
not to others.

For general information about assigning and managing ACLs, see the webMethods Service
Development Help.
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Before Configuring or Managing Adapter Connections

To prepare to configure or manage an adapter connection

1. Install webMethods Integration Server and SOPERAAdapter on the samemachine. For details,
see “Installing webMethods SOPERA Adapter ” on page 21.

2. Make sure you havewebMethods administrator privileges so that you can access the SOPERA
Adapter’s administrative screens. For information about setting user privileges, see the
webMethods Integration Server Administrator’s Guide for your release.

3. Start Integration Server and Integration Server Administrator, if they are not already running.

4. Using Integration Server Administrator, make sure the SOPERA package is enabled. See
“Enabling and Disabling Packages” on page 33 for instructions.

5. Using Software AG Designer, create a user-defined package to contain connections, if you
have not already done so. See “Managing the Adapter Package” on page 32 for instructions.

Configuring Adapter Connections

SOPERA Adapter requires a connection to the SOPERA infrastructure whenever services from
the SOPERA infrastructure are to be invoked. That is, whenever SOPERA Adapter acts as a client
for a SOPERA infrastructure. A connection is also required when an Integration Server service is
to be invoked through the adapter by any of the SOPERA participants.

When you configure SOPERA Adapter connections, you specify information that Integration
Server uses to connect to a SOPERA participant. In most cases, you will need to configure at least
two adapter connections: one for the adapter listener and one for all adapter services.

To configure an adapter connection

1. In Integration Server Administrator, select Adapters > SOPERA Adapter.

2. On the Connections screen, click Configure New Connection.

3. On the Connection Type screen, click SOPERA Connection as the connection type.

4. Complete the following fields in the SOPERA Adapter section:

Description/ActionField

The package in which to create the connection. You must create the
package using Designer before you can specify it using this parameter.

Package
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Description/ActionField

For general information about creating packages, see the webMethods
Service Development Help.

Note:
Configure the connection in a user-defined package rather than in the
adapter’s package. See “Package Management” on page 31 for other
important considerationswhen creatingpackages for SOPERAAdapter.

The folder in which to create the connection.Folder Name

The name of the new connection.Connection Name

5. In the Connection Properties section, complete the following fields using the values from
your configured SOPERA infrastructure:

Description/ActionField

The location of the SOPERA infrastructure. The default value is
generic_location.

SOPERA Location

The SOPERAdefault user name for this adapter connection. For example,
SOPAdministrator.

SOPERA User

The password for the SOPERA default user name.SOPERA
Password

Note:
You must retype the password in the Retype SOPERA Password
field.

6. In theConnection Management Properties section, complete the following fields to configure
connection pool sizes:

Description/ActionField

Enables the connection to use connection pooling.Enable
Connection
Pooling Default: true

For more information about connection pooling, see “Connection
Pools” on page 12.

Theminimumnumber of connection objects that remain in the connection
pool at all times.When the adapter creates the pool, it creates this number
of connections.

Minimum Pool
Size

Default: 1
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Description/ActionField

The maximum number of connection objects that can exist in the
connection pool. When the connection pool has reached its maximum

Maximum Pool
Size

number of connections, the adapter will reuse any inactive connections
in the pool or, if all connections are active, it will wait for a connection
to become available.

Default: 10

If connection pooling is enabled, this field specifies the number of
connections by which the pool will be incremented if connections are
needed, up to the maximum pool size.

Pool Increment
Size

Default: 1

If connection pooling is enabled, this field specifies the number of
milliseconds that Integration Serverwill wait to obtain a connectionwith
the SOPERA infrastructure before it times out and returns an error.

Block Timeout
(msec)

Default: 1000

If connection pooling is enabled, this field specifies the number of
milliseconds that an inactive connection can remain in the pool before it

Expire Timeout
(msec)

is closed and removed from the pool. For example, to specify 10 seconds,
specify 10000. Enter 0 to specify no timeout.

Default: 1000

Note:
The adapter will never violate theMinimum Connections parameter.
These connections remain in the pool regardless of how long they are
inactive.

The number of times that the system should attempt to initialize the
connection pool at startup if the initial attempt fails.

Startup Retry
Count

Default: 0

Theminimumnumber of connection objects that remain in the connection
pool at all times.When the adapter creates the pool, it creates this number
of connections.

Startup Backoff
Timeout (sec)

Default: 10

7. Click Save Connection.

The connection that you configured appears on the adapter’s Connections screen and in the
Designer Package Navigator view.

By default, when you configure a connection, it is not enabled. Formore information about enabling
connections, see “Enabling Adapter Connections” on page 41.
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Enabling Adapter Connections

A connectionmust be enabled before you can configure any adapter service using the connection,
or before an adapter service can use the connection at run time. You enable adapter connections
using Integration Server Administrator.

Note:
Whenyou reload a package that contains enabled connections, the connectionswill automatically
be enabled when the package reloads. If the package contains connections that are disabled,
they will remain disabled when the package reloads.

To enable a connection

1. In Integration Server Administrator, select Adapters > SOPERA Adapter.

2. On the Connections screen, click No in the Enabled column for the connection you want to
enable.

Integration Server Administrator enables the adapter connection and displays Yes in the
Enabled column.

Viewing Adapter Connections from Integration Server
Administrator

You can view adapter connections and each connection’s parameters from Integration Server
Administrator or Designer.

To view the adapter connections using Integration Server Administrator

1. Make sure the connection is enabled. See “Enabling Adapter Connections” on page 41 for
details.

2. In Integration Server Administrator, select Adapters > SOPERA Adapter.

You can sort and filter the list of connections that appears on the Connections screen.

To sort information on the Connections screen, click the Up and Down arrows.

To filter the list of connections:

1. On the Connections screen, click Filter Connections.

2. Type the criterion by which you want to filter into the Filter criteria box. Filtering is
based on the node name, not the connection alias. To locate all connections containing
specific alphanumeric characters, use asterisks (*) as wildcards. For example, if you
want to display all connections containing the string "abc", type *abc* in the Filter
criteria box.
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3. Click Submit. The Connections screen displays the connections that match the filter
criteria.

4. To re-display all connections, click Show All Connections.

The Connections screen appears, listing all the current connections. You can control the
number of connections that are displayed on this screen. For more information, see
“Controlling Pagination” on page 19.

On the Connections screen, click the View icon for the connection you want to see.

The View Connection screen displays the parameters for the connection. For descriptions
of the connection parameters, see the table of parameters in “Configuring Adapter
Connections” on page 38.

3. Click Return to SOPERA Adapter Connectionsto return to the Connections screen.

Viewing Adapter Connections in Designer

To view the parameters for a connection using Designer

1. Start Designer if it is not already running.

2. From the Designer Package Navigator view, open the package and folder in which the
connection is located.

3. Double-click the connection you want to view.

4. The parameters for the connection appear on theConnection Information tab. For descriptions
of the connection parameters, see “Configuring Adapter Connections” on page 38.

Disabling Adapter Connections

SOPERA Adapter connections must be disabled before you can edit or delete them. You disable
adapter connections using Integration Server Administrator.

To disable a connection

1. In Integration Server Administrator, select Adapters > SOPERA Adapter.

2. On the Connections screen, click Yes in the Enabled column for the connection you want to
disable.

The adapter connection becomes disabled and you see a No in the Enabled column.
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Editing Adapter Connections

If a connection parameter changes, or if you want to redefine parameters that a connection uses
when connecting to a SOPERA infrastructure, you can update a connection’s parameters using
Integration Server Administrator.

To edit a connection

1. In Integration Server Administrator, select Adapters > SOPERA Adapter.

2. Make sure that the connection is disabled before editing it. See “Disabling Adapter
Connections” on page 42 for instructions.

3. On the Connections screen, click the Edit icon for the connection you want to edit.

The Edit Connection screen displays the current parameters for the connection. Update the
connection’s parameters by typing or selecting the values you want to specify.

For descriptions of the connection parameters, see “Configuring Adapter Connections” on
page 38.

4. Click Save Changes to save the connection and return to the Connections screen.

Copying Adapter Connections

You can copy an existing SOPERA Adapter connection to configure a new connection with the
same or similar connection properties without having to retype all of the properties for the
connection. You copy adapter connections using Integration Server Administrator.

To copy a connection

1. In Integration Server Administrator, select Adapters > SOPERA Adapter.

2. On the Connections screen, click the Copy icon for the connection you want to copy.

The Copy Connection screen displays the current parameters for the connection you want to
copy. Name the new connection, specify a package name and folder name, and edit any
connection parameters as needed by typing or selecting the values you want to specify.

Note:
When you copy a connection, the new connection does not save the password of the original
connection. You must enter and then retype the password before you can save the new
connection.

For descriptions of the connection parameters, see “Configuring Adapter Connections” on
page 38.
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3. Click Save Connection to save the connection and return to the Connections screen.

Deleting Adapter Connections

If you no longerwant to use a particular SOPERAAdapter connection, you candelete it by following
the instructions in this section. You delete adapter connections using Integration Server
Administrator.

If you delete a connection, the adapter services or notifications that are defined to use the connection
will no longerwork.However, you can changewhich connection an adapter service uses. Therefore,
if you delete a connection, you can assign a different connection to an adapter service and re-use
the service. To do this, you use the built-in functionsetAdapterServiceNodeConnection. For more
information, see “Changing theConnectionAssociatedwith anAdapter Service at Design Time” on
page 13.

To delete a connection

1. In Integration Server Administrator, select Adapters > SOPERA Adapter.

2. Make sure that the connection is disabled before deleting. To disable the connection, click Yes
in theEnabled column and clickOK to confirm. TheEnabled columnnow showsNo (disabled)
for the connection.

3. On the Connections screen, click the Delete icon for the connection you want to delete.

Integration Server deletes the adapter connection.
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Before Configuring or Managing Adapter Services

To prepare to configure or manage an adapter service

1. Start your Integration Server and Integration Server Administrator, if they are not already
running.

2. Make sure you have Integration Server administrator privileges so that you can access SOPERA
Adapter administrative screens. For information about setting user privileges, see the
webMethods Integration Server Administrator’s Guide for your release.

3. Using Integration Server Administrator, make sure theWmSoperaAdapter package is enabled.
For instructions, see “Enabling a Package” on page 33.

4. Using Integration Server Administrator, configure an adapter connection to use with the
adapter service. For instructions, see “Configuring Adapter Connections” on page 38.

5. Start Designer if it is not already running.

6. Using Designer, create a package to contain adapter services, if you have not already done so.

When you configure adapter services, define them in user-defined packages instead of in the
WmSoperaAdapter package. For more information about managing packages for the adapter,
see “Package Management” on page 31.

Using Adapter Services

The following table lists the task required to use adapter services.

Use this toolTask

Integration Server
Administrator

1. Configure an adapter connection. For instructions, see
“Configuring Adapter Connections” on page 38.

Designer2. Select the appropriate adapter service template and configure
the adapter service. For instructions, see “Configuring Adapter
Services” on page 47.

Designer3. If you plan to use an Integration Server flow or Java service to
invoke the adapter service, design the flow or Java service to use
this adapter service. For information about flow and Java services,
see the webMethods Service Development Help.

Integration Server
Administrator and Designer

4. Manage the adapter service.
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Configuring Adapter Services

Every invocation of a SOPERA service by other Integration Server services or Integration Server
clients goes through an adapter service. The SOPERA Adapter provides the following adapter
service templates:

SOPERA Generic Consumer

SOPERA Notification Provider

SOPERA Callback Sender Provider

You configure adapter services in Designer.

SOPERA Generic Consumer
The SOPERA Generic Consumer adapter services perform the actual invocation of a SOPERA
service. In general, you can use the SOPERAAdapter service consumer template to configure two
kinds of service invocation adapter services:

Adapter service tailored to a specific SOPERA service and operation.

Adapter service that invokes any SOPERA service and operation.

Configuring a Service for a Specific SOPERA Service and Operation

This configuration is accomplished by selecting a specific SOPERA service and one of its operations
that the adapter servicewill provide. In this case, one adapter service is required for every SOPERA
service operation. In most cases, it is better to use one adapter service per SOPERA service. The
SOPERA registry ensures that a valid SOPERA servicewith a valid operation is used. Additionally,
these adapter services are more easily reused in flow services and business processes.

For this configuration, use the SOPERA Generic Consumer adapter service template to configure
the parameters for the new service as described in the following procedure.

To configure an adapter service that invokes a specific SOPERA service

1. Start Designer.

2. Right-click the package in which the service should be contained and select New > Adapter
Service.

3. Select the parent namespace and type a name for the adapter service.

4. Click Next.

5. Select SOPERA Adapter as the adapter type and click Next.
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6. Select the appropriate Adapter Connection Name and click Next.

7. Select the SOPERA Generic Consumer adapter template and click Finish.

The adapter service editor for the invocation service appears.

8. In the service editor, select the Adapter Settings tab at any time to confirm adapter service
properties such as Adapter Name, Adapter Connection Name, and Adapter Service
Template, as necessary.

9. In the service editor, select the SOPERA Generic Consumer tab and specify values in the
fields, based on the type of consumer service you want to configure:

For request-response consumer services, see “Configuring Request-Response Consumer
Services” on page 48.

For one-way consumer services, see “ConfiguringOne-WayConsumer Services” onpage 50.

For request-callback consumer services, see “Configuring Request-Callback Consumer
Services” on page 51.

10. From the File menu, click Save.

Using the XML schema of the SOPERAoperations retrieved from the registry, the SOPERAAdapter
automatically creates Integration Server input and output document types adhering to the
operation’s schema.

When the adapter service is invoked, the data is automatically transformed into XML and passed
to the SOPERA service. When the service returns the result, the XML is then transformed back
into structured data elements that business processes, services, and clients can easily use inside
Integration Server.

Configuring Request-Response Consumer Services

When youwant to create a request-response consumer, you configure a request-response consumer
service using the SOPERA Generic Consumer template. For the steps to configure the service, see
“Configuring a Service for a Specific SOPERA Service and Operation” on page 47. The following
table describes the required fields and the values you provide for a request-response consumer
service:

DescriptionField

The name and the path to the SOPERA service to invoke. For example,
{http://services.sopware.org/ExampleURI}ExampleService

Service name

The name of the operation the adapter service must perform. For example.
Select RequestResponseOperation

Operation name

Leave empty.Callback
Operation Name
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DescriptionField

Do not select.Send request only

The way in which the adapter service interacts with the SOPERA
infrastructure.

Interaction style

When you select the request-response operation in theOperation namefield,
the value in this field changes automatically to REQUEST_RESPONSE.

The fully qualified document type name for the input IS document. For
example, doc.myservice.input:inDoc

Input document
type

Important:
Specify a unique name for the input document type. If you specify an
existing document type name, the IS document type will not be generated
correctly.

The fully qualified document type name for the output IS document. For
example, doc.myservice.output:inDoc

Output document
type

Important:
Specify a unique name for the output document type. If you specify an
existing document type name, the IS document type will not be generated
correctly.

The conditions under which the adapter service invokes a SOPERA service.
SOPERAAdapter retrieves policies from the SOPERAService Registry based

Policy

on the location configured in the Connection Settings. For information about
configuring the adapter connection settings, see “Configuring Adapter
Connections” on page 38.

Determines the invocation style of the adapter service:Blocking

When selected, the adapter service is configured as blocking and it waits
for the actual service result. By default, blocking is selected.

When not selected, the adapter service is configured as non-blocking and
returns a responsemessage handler. This message handler can be passed
to the pub.wmsopera.service:getNonBlockingServiceResponseutility service, using
a flow service that gets the actual result. This allows a complex service
to start as soon as all of its input parameters are available and to only
block when the output of the service is needed.

Determines how the service provider returns the response message to the
service consumer.

Return the actual
message object

When not selected, the response message is transformed into Integration
Server data structures. This is the default.

When selected, the responsemessage returns as an actualmessage object.
This is useful when a response message contains attachments or is very
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DescriptionField

large, because an actual message object enables you to retrieve the
attachments or the message content in a stream-based manner.

Note:
If the response contains attachments, then the response is returned as an
objectwhether you select this option or not. Ensure that the adapter services
are configured appropriately.

Configuring One-Way Consumer Services

When you want to create a one-way consumer, you configure a one-way consumer service using
the SOPERAGeneric Consumer template. For the steps to configure the service, see “Configuring
a Service for a Specific SOPERA Service and Operation” on page 47. The following table describes
the required fields and the values you provide for a one-way consumer service:

DescriptionField

The name and the path to the SOPERA service to
invoke. For example,
{http://services.sopware.org/ExampleURI}ExampleService

Service name

The name of the operation the adapter servicemust
perform. Select OneWayOperation.

Operation name

Leave empty.Callback Operation Name

Do not select.Send request only

Theway inwhich the adapter service interactswith
the SOPERA infrastructure.

Interaction style

When you select the one-way operation in the
Operation name field, the value in this field
changes automatically to ONEWAY.

The fully qualified document type name for the
input IS document. For example,
doc.myservice.input:inDoc

Input document type

Important:
Specify a unique name for the input document
type. If you specify an existing document type
name, the IS document typewill not be generated
correctly.

When the Interaction style is ONEWAY, no output
document type is required or generated.

Output document type
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DescriptionField

The conditions under which the adapter service
invokes a SOPERA service. SOPERA Adapter

Policy

retrieves policies from the SOPERAServiceRegistry
based on the location configured in the Connection
Settings. For information about configuring the
adapter connection settings, see “Configuring
Adapter Connections” on page 38.

Do not select.Blocking

Do not select.Return the actual message object

Configuring Request-Callback Consumer Services

When youwant to create a request-callback consumer, you configure a request-callback consumer
service using the SOPERA Generic Consumer template. For the steps to configure the service,
see“Configuring a Service for a Specific SOPERA Service and Operation” on page 47. However,
there are two ways two create a request-callback consumer as described in “Creating Service
Consumers” on page 15. Based on the method you use, you provide different values in the
Operation name, Send request only, and Output document type template fields. The values
in the remaining fields are the same for both methods:

DescriptionField

The name and the path to the SOPERA service to invoke.
For example,
{http://services.sopware.org/ExampleURI}ExampleService

Service name

When you want to create an adapter consumer service
that uses one of the request-callback operations, select
the respective request-callback operation.

Operation name

Callback Operation name The name of the callback operation that corresponds
to the request-callback operation selected in the
Operation name field.

When the Send request only checkbox is selected,
leave this field empty.

Send request only When youwant to create an adapter service that only
submits a request and has a listener for receiving the
callback, select this box.

When youwant to receive the response as part of the
consumer service, do not select this box.
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DescriptionField

When you select one of the request-callback operations
in the Operation name field, the value in this field
changes automatically to REQUEST_CALLBACK.

Interaction style

The fully qualified document type name for the input IS
document. For example, doc.myservice.input:inDoc

Input document type

Output document type When you want to create a consumer service that
uses one of the request-callback operations, provide
the fully qualified document type name for the
output IS document. For example,
doc.myservice.output:inDoc.

In this case, the signature of the adapter service will
contain only one output parameter:
responseMessageHandler. You can use the
responseMessageHandler parameter as input to the
pub.wmsopera.service:getNonBlockingServiceResponse
service that will wait and block for the actual result.
The consumer service and the
getNonBlockingServiceResponse service function
together inmuch the sameway as for a non-blocking
request-response style. For more information about
the getNonBlockingServiceResponse service, see
pub:wmsopera.service:getNonBlockingServiceResponse.

When youwant to create an adapter service that only
submits a request, leave this field empty.

In this case, the consumer service does not have any
output parameters. You must configure an adapter
notification to receive the callback. For information
about how to configure a consumer adapter
notification, see “ SOPERA Callback Consumer” on
page 73.

The conditions under which the adapter service invokes
a SOPERA service. SOPERA Adapter retrieves policies

Policy

from the SOPERAService Registry based on the location
configured in the Connection Settings. For information
about configuring the adapter connection settings, see
“Configuring Adapter Connections” on page 38.

Do not select.Blocking

Do not select.Return the actual message object:

Configuring a Service for Any SOPERA Service and Operation
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In this configuration the SOPERA service and operation are parameters of the adapter service.
The benefits of this approach are increased flexibility (run-time selection of SOPERA service is
possible) and less configuration overhead (only one adapter service can be used for multiple
SOPERA service invocation).

To configure a generic invocation adapter service, use the same procedure as described in the
“Configuring a Service for a Specific SOPERA Service and Operation” on page 47 section, but
leave the fields on the SOPERA Generic Consumer tab blank. Specify configuration values as
input values for the adapter service parameters that you can view on the Input/Output tab of the
adapter service template:

Input Parameters

The name of the SOPERA service.serviceName

The name of the operation to perform for the adapter service.operationName

The policy identifier for the SOPERA service.policyId

The request that the adapter service sends as an XML String.requestMessageString

Output Parameters

The response message as an XML String, when the Return the actual
message object field on the SOPERA Generic Consumer tab is set to
false.

responseMessageString

The responsemessage as anObject,when theReturn the actual message
object field on the SOPERA Generic Consumer tab is set to true.

responseMessageObject

When the response contains attachments, the response always returns as
a responseMessageObject.

The message handler passed to the
pub.wmsopera.service:getNonBlockingServiceResponse utility service when the
communication style is request-response non-blocking.

responseMessageHandler

SOPERA Notification Provider
You use the SOPERA Notification Provider service template to create an adapter service that
functions as a service provider when using the SOPERA notification communication style. For
more information about the SOPERAnotification style and service providers, see “Communication
Styles Support” on page 15 and “Creating Service Providers” on page 16.

To create a SOPERA notification provider adapter service

1. Start Designer.

webMethods SOPERA Adapter Installation and User’s Guide 8.0 53

5 Adapter Services



2. Right-click the package in which the service should be contained and select New > Adapter
Service.

3. Select the parent namespace and type a name for the adapter service.

4. Click Next.

5. Select SOPERA Adapter as the adapter type and click Next.

6. Select the appropriate Adapter Connection Name and click Next.

7. Select the SOPERA Notification Provider adapter template and click Finish.

The adapter service editor for the notification service appears.

8. In the service editor, select the Adapter Settings tab at any time to confirm adapter service
properties such as Adapter Name, Adapter Connection Name, and Adapter Service
Template, as necessary.

9. In the service editor, select the SOPERA Notification Provider tab and specify values in the
following fields based on the method for creating a provider that you want to use:

a. Using an existing IS document type:

DescriptionField

The name and the path to the new SOPERA notification service. For
example, {http://services.sopware.org/ExampleURI}ExampleService

Service name

The name of the operation for the SOPERA service. For example,
notify

Operation name

The fully qualified document type name for an existing IS document.
For example, doc.myservice.output:notificationDoc

Input document
type

Do not select.Use existing
SOPERA service

Based on the IS document type that you specify, SOPERA Adapter creates the notification
operation in the service registry.

b. Using the SDX-first approach:

DescriptionField

The name of the SOPERA service. For example,
{http://services.sopware.org/ExampleURI}ExampleService

Service name
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DescriptionField

The nameof one of the notification operations for the SOPERAservice.
For example, notifyForArrival

Operation name

The fully qualified document type name for the IS document that
will be generated. For example, doc.myservice.input:notifyDoc

Input document
type

Select this box.Use existing
SOPERA service:

SOPERAAdapter creates an IS document type thatmatches the signature of the notification
operation in the existing SOPERA service.

10. On the JMS Provider Settings tab, provide values for the following fields:

DescriptionField

The name of the JMS MOM Provider. Select ActiveMQ.JMS Provider

The JMS communication style. Select topic.JMS Communication
Style

Location of the JNDI. For example, tcp://dewm:61616JNDI URL

11. From the File menu, click Save.

SOPERA Callback Sender Provider
The SOPERA Callback Sender Provider template is used in one of the methods for creating a
request-callback provider. With this method you first create an adapter notification that receives
the request and publishes a document. For information about how to create the callback provider
adapter notification, see “ SOPERA Generic Provider” on page 69. Then using the SOPERA
Callback Sender Provider template, you create an adapter service that sends a response to the
request.

The adapter notification publishes a document that contains the callContextKey parameter which
the adapter service uses to correlate the callback with the request. You can also store the
callContextKey in a database during a long running operation, wait for input from an external
system, retrieve the callContextKey from the database, and invoke the consumer callback operation.

To create a Callback Sender Provider adapter service

1. Start Designer.

2. Right-click the package in which the service should be contained and select New > Adapter
Service.
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3. Select the parent namespace and type a name for the adapter service.

4. Click Next.

5. Select SOPERA Adapter as the adapter type and click Next.

6. Select the appropriate Adapter Connection Name and click Next.

7. Select the SOPERA Callback Sender Provider adapter template and click Finish.

The adapter service editor for the callback service appears.

8. In the service editor, select the Adapter Settings tab at any time to confirm adapter service
properties such as Adapter Name, Adapter Connection Name, and Adapter Service
Template, as necessary.

9. In the service editor, select the SOPERA Callback Sender Provider tab and specify the
following values:

DescriptionField

The name and path to an existing SOPERA service. For example,
{http://services.sopware.org/ExampleURI}UpperCallback

Service name

The name of the SOPERA service operation. For example, getUpper.Operation name

The name of the callback operation corresponding to the one specified
in the Operation name field. For example, getUpperResponse.

Callback
Operation name

When you select one of the request-callback operations in the Operation
name field, the value in this field changes automatically to
REQUEST_CALLBACK.

Interaction style

The fully qualified document type name for the IS Document that will
be generated. This document is the response to the callback operation.
For example, doc.myservice.output:callbackDoc

Output document
type

10. From the File menu, click Save.

Testing Adapter Services

You use Designer to test adapter services.

Formore information about testing and debugging services, see thewebMethods Service Development
Help.

To test adapter services
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1. In Designer, expand the package and folder that contain the service you want to test.

2. Double-click the service you want to test.

Designer displays the configured service in the service template’s adapter service editor.

3. Select Run > Run As > Run Service.

4. For every service input field, you will be prompted to enter an input value. Enter a value for
each input field and then click OK.

5. Click the Service Result tab to view the output from this service.

Viewing Adapter Services

You use Designer to view adapter services.

To view adapter services

1. In Designer, expand the package and folder that contain the service you want to view.

2. Double-click the service you want to view.

Designer displays the configured service in the service template’s adapter service editor.

Editing Adapter Services

You use Designer to edit adapter services.

To edit an adapter service

1. In Designer, browse to and open the adapter service that you want to edit.

2. Double-click the service that you want to edit.

Designer displays the adapter service in the service template's Adapter Service Editor.

3. Do one of the following:

If you have the VCS Integration feature enabled, right-click the service and select Check
Out.

If you do not have the VCS Integration feature enabled, right-click the service and select
Lock for Edit.
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If you are using the local service development feature, from the Team menu in Designer,
select the appropriate option to check out the service. The options available in the Team
menu depend on the VCS client that you use.

4. Modify the values for the adapter service's parameters as needed. For detailed descriptions of
the service's parameters, see the section on configuring a service for the specific type of service
you want to edit.

5. After you complete your modifications, save the service and do one of the following:

If you have the VCS Integration feature enabled, right-click the service and select Check
In. Enter a check-in comment and click OK.

If you do not have the VCS Integration feature enabled, right-click the service and select
Unlock.

If you are using the local service development feature, from the Team menu in Designer,
select the appropriate option to check in the service. The options available in the Team
menu depend on the VCS client that you use.

6. Save the service.

Deleting Adapter Services

You use Designer to delete adapter services.

To delete adapter services

1. In Designer, expand the package and folder that contain the service you want to delete.

2. Right-click the service you want to delete and then select Delete.

Automatic Data Validation and Reloading Adapter Values

You can enable SOPERA Adapter to reload and validate user-defined data for adapter services at
design time in Designer.

Disabling Data Validation
The automatic data validation for adapter services is enabled by default in Designer. When the
option is selected, Designer always validates values for adapter services for all webMethods
WmART-based adapters installed on Integration Server.

To disable automatic data validation for all adapter services

1. Start Designer.
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2. Select Window > Preferences > Software AG > Service Development > Adapter
Service/Notification Editor.

3. Disable the Automatic data validation option.

4. Click OK.

For more information about the adapter service/notification editor and other Designer menu
options and toolbar icons, see webMethods Service Development Help.

Reloading Adapter Values
The option to always reload values for adapter services is disabled by default in Designer. If you
enable that option, Designerwill always reload values for all webMethodsWmART-based adapters
installed on Integration Server.

To reload the adapter values for all adapter services

1. Start Designer.

2. Select Window > Preferences > Software AG > Service Development > Adapter
Service/Notification Editor.

3. Enable the Automatic polling of adapter metadata option.

4. Click OK.

For more information about the adapter service/notification editor and other Designer menu
options and toolbar icons, see the webMethods Service Development Help.
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Listeners

This section describes how to create, modify, and delete listeners.

Before You Configure New Listeners

To prepare to configure a new listener

1. Make sure that you have webMethods administrator privileges so that you can access
webMethods SOPERA Adapter’s administrative screens. For information about setting user
privileges, see the webMethods Integration Server Administrator’s Guide for your release.

2. Start Integration Server and Integration Server Administrator, if they are not already running.

3. Using Integration Server Administrator, make sure that the WmSoperaAdapter package is
enabled. To verify the status of the WmSoperaAdapter package, see “Enabling and Disabling
Packages” on page 33.

4. Using Designer, create a user-defined package to contain the listener, if you have not already
done so. For more information about managing packages, see “Package Management” on
page 31 for details.

Configuring Listeners
SOPERAAdapter requires a listener to listen for inbound requests from the SOPERA infrastructure.
Use the following procedure to create a listener on SOPERAAdapter to respond to requests issued
by the SOPERA infrastructure.

To create a listener on SOPERA Adapter

1. In Integration Server Administrator, select Adapters > SOPERA Adapter.

2. In the SOPERA Adapter menu, click Listeners.

3. Select Configure new listener and then select  SOPERA invocation listener from the list of
available listener types.

4. Complete the following fields on the Configure Listener Type screen:

Description/ActionField

The package in which to create the listener. You must create the package
using Designer before you can specify it using this parameter. For general

Package
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Description/ActionField

information about creating packages, see thewebMethods Service Development
Help.

Note:
Configure the listener in a user-defined package rather than in the
adapter’s package. See “Package Management” on page 31 for other
important considerations when creating packages for SOPERA Adapter.

The folder in which to create the listener.Folder Name

The name of the new listener.Listener Name

The name of the connection to associate with the new listener.Connection Name

From the list of connections, select an appropriate connection that you created
on the Configure Connections Type screen.

The number of times the adapter tries to reconnect if the adapter fails to
connect, or loses connection with the SOPERA infrastructure.

Retry Limit

Default: 5

The number of seconds that elapse between each of the retries specified in
the retry limit.

Retry Backoff
Timeout

Default: 10

5. Click Save Listener.

The adapter listener is created. The listener name is prefixed by the folder name and is separated
by a colon. For example: If the folder name is “Folder1” and the listener name is “Listener1”, then
the listener name in the Listeners screen will be “Folder1:Listener1”.

Enabling Listeners
After you have configured notifications, you must enable the listener so that the associated
notificationswill communicate appropriatelywith the listener at run time. You enable the listeners
using Integration Server Administrator.

The Status column indicates the readiness of the listener. If the status is Succeeded, the listener
is ready to be enabled. If the status is Failed, an error occurred during startup. If an error occurs
during startup, the state will not change to Enabled when refreshing the page. Errors at this stage
typically indicate a problem with either the listener configuration or the network. Review the
listener settings and check the network.

Note:
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When you reload a package that contains enabled listeners, the listeners will be enabled
automatically when the package reloads. If the package contains disabled listeners, they will
remain disabled when the package reloads.

To enable a listener

1. In Integration Server Administrator, select Adapters > SOPERA Adapter.

2. In the SOPERA Adapter menu, click Listeners.

3. On the Listeners screen, select Enabled from the list in the State field. Integration Server
Administrator enables the listener.

4. The state changes to Pending enabled. After refreshing the Listeners page, you should see
the state changed to Enabled.

After a listener is enabled, a connection exists between SOPERA Adapter and the SOPERA
infrastructure.

Tip:
The Enable all suspended link helps you change the state quickly for multiple listeners.

Viewing Listeners
You can view listeners and each listener’s parameters from Integration Server Administrator. You
can also view the notification order of a listener.

To view listeners

1. In Integration Server Administrator, select Adapters > SOPERA Adapter.

2. In the SOPERA Adapter menu, click Listeners. The Listeners screen appears, listing all of
the current listeners.

3. To view a listener’s parameters:

a. On the Listeners screen, click the View icon for the listener that you want to see.

b. The View Listener screen displays the parameters for the listener.

4. Click View Notification Order to view the notification order of a listener.

The View Listener screen displays the order of the notifications for the listener. To change the
notification order for the listener, refer to the procedure in “Editing the Notification Order of
Listeners” on page 65 for detailed instructions.
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5. Click Return to SOPERA Adapter Listeners to return to the Listeners screen.

Editing Listeners
You use Integration Server Administrator to edit the listener in the following situations:

If you need to select a newly configured connection, or if you need to change any listener
properties you can update the listener parameters.

If you need to change the order of the notifications that are associated with the listener.

To edit a listener

1. In Integration Server Administrator, select Adapters > SOPERA Adapter.

2. In the SOPERA Adapter menu, click Listeners.

3. On the Listeners screen, make sure that the listener is disabled before editing. To disable the
listener, see “Disabling Listeners” on page 67.

4. On the Listeners screen, click the Edit icon for the listener that you want to edit.

The Edit Listener screen displays the current parameters for the listener. Update the listener’s
parameters by typing or selecting the values you want to specify.

For descriptions of the listener parameters, see “Configuring Listeners” on page 62.

5. Click Save Changes to save the listener and return to the Listeners screen.

Editing the Notification Order of Listeners

To edit the notification order of a listener

1. In Integration Server Administrator, select Adapters > SOPERA Adapter.

2. In the SOPERA Adapter menu, click Listeners.

3. On the Listeners screen, make sure that the listener is disabled before editing. To disable the
listener, see “Disabling Listeners” on page 67 for details.

4. On the Listeners screen, click the Edit icon for the listener that you want to edit.

5. On the Edit Listener screen, click Edit Notification Order.
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6. On the EditNotificationOrder screen, use theUp andDown buttons to determine the processing
order in which SOPERA Adapter invokes the notifications.

Note:
For better processing results, arrange your notifications from ascending to descending order,
starting with the most detailed notifications to the least detailed notifications.

7. Click Save Changes.

8. Click Return to Edit Listeners to return to the Edit Listener screen.

Copying Listeners
You can copy an existing listener to create a new listener with the same or similar properties
without having to type or specify all properties for the listener. You copy adapter listeners using
Integration Server Administrator.

To copy a listener

1. In Integration Server Administrator, select Adapters > SOPERA Adapter.

2. In the SOPERA Adapter menu, click Listeners.

3. On the Listeners screen, click the Copy icon for the listener that you want to copy.

The Copy Listener screen displays the current parameters for the listener that you want to
copy. Name the new listener and edit any listener parameters as needed by typing or selecting
the values you want to specify.

For descriptions of the listener parameters, see “Configuring Listeners” on page 62.

4. Click Save Changes to save the listener and return to the Listeners screen.

Deleting Listeners
If you no longer want to use a listener, use the following instructions to delete the listener. You
use Integration Server Administrator to delete listeners.

Important:
Ensure that there are no notifications attached to the listener that you delete. You cannot change
which listener a notification uses after the notification is configured. However, you can change
the parameters for an existing listener. For instructions, see “Editing Listeners” on page 65.

To delete a listener

1. In Integration Server Administrator, select Adapters > SOPERA Adapter.
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2. In the SOPERA Adapter menu, click Listeners.

3. On the Listeners screen, make sure that the listener is disabled before deleting it. To disable
the listener, see “Disabling Listeners” on page 67 for details.

4. On the Listeners screen, click the Delete icon for the listener you want to delete.

Integration Server deletes the listener.

Suspending Listeners
You can suspend listeners for an indefinite period of time. Suspended listeners cannot be edited
or deleted.

Important:
Suspending listeners for SOPERA Adapter has the same effect as disabling them. For more
information about disabling listeners, see “Disabling Listeners” on page 67.

To suspend listeners

1. In Integration Server Administrator, select Adapters > SOPERA Adapter.

2. In the SOPERA Adapter menu, click Listeners.

3. Click Suspend all enabled to change the state to suspended for multiple listeners.

When you suspend a listener, the action might not take effect right away. You might have to
wait as long as the time specified in the Timeout parameter for the listener. If one or more
messages appear on the queue within that time interval, the adapter may receive and process
the first message.

Disabling Listeners
Listenersmust be disabled before you can edit or delete them. Youdisable listeners using Integration
Server Administrator.

To disable a listener

1. In Integration Server Administrator, select Adapters > SOPERA Adapter.

2. In the SOPERA Adapter menu, click Listeners.

3. On the Listeners screen, select Disabled from the list in the State field. Integration Server
Administrator disables the listener.
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When you disable a listener, the action might not take effect right away. You might have to
wait as long as the time specified in the Timeout parameter for the listener. If one or more
messages appear on the queue within that time interval, the adapter may receive and process
the first message.

Listener Notifications

This section describes how to create, modify, and delete listeners notifications.

To prepare to configure a new listener notification

1. Make sure that you havewebMethods administrator privileges so that you can access SOPERA
Adapter’s administrative screens. For information about setting user privileges, see the
webMethods Integration Server Administrator’s Guide for your release.

2. Start Integration Server and Integration Server Administrator, if they are not already running.

3. Using Integration Server Administrator, make sure that the WmSoperaAdapter package is
enabled. To verify the status of the WmSoperaAdapter package, see “Enabling and Disabling
Packages” on page 33.

4. Configure a listener using Integration Server Administrator. For more information on how to
configure a new listener, see “Configuring Listeners” on page 62.

5. Using Designer, create a user-defined package to contain the listener, if you have not already
done so. For more information about managing packages, see “Package Management” on
page 31 for details.

Dependencies for Listener Notifications
The following table lists other objects youmust configure or tasks youmust complete to use listener
notifications:

Use this toolTask

Integration Server
Administrator

1. Configure an adapter connection. For details, see “Configuring
Adapter Connections” on page 38.

Integration Server
Administrator

2. Configure an adapter listener. For details, see “Configuring
Listeners” on page 62.

Designer3. Configure the notification. For instructions on how to configure
notifications, see “Configuring Listener Notifications” on page 69.

Integration Server
Administrator

4. Enable the notifications. For instructions on how to enable
notifications, see “Enabling Listener Notifications” on page 76.
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Configuring Listener Notifications
You configure listener notifications using Designer. SOPERA Adapter provides the following
adapter notification templates that you use to configure listener notifications:

SOPERA Generic Provider

SOPERA Notification Consumer

SOPERA Callback Consumer

SOPERA Request-Callback Provider

SOPERA Generic Provider

The following procedure describes the steps to configure a SOPERA Generic Provider listener
notification using the SOPERAGeneric Provider template. You use this type of listener notification
to create:

Request-response service providers

One-way service providers

Request-callback service providers that consist of a listener notification that calls an IS service
and returns the output of that service as the callback.

To configure a Generic Provider listener notification

1. Start Designer.

2. Right-click the package inwhich the notification should be contained and selectNew > Adapter
Notification.

3. Select the parent namespace and type a name for the adapter notification.

4. Click Next.

5. Select SOPERA Adapter as the adapter type and click Next.

6. Select the SOPERA Generic Provider notification template and click Next.

7. Select the appropriate Notification Listener Name and click Next.

8. Click Finish.

Designer creates a listener notification and a publishable document type, and the editor for
the adapter notification appears.
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9. In the editor for adapter notifications, select the Adapter Settings tab to confirm notification
properties such as the Adapter Name, Adapter Listener Name, and Adapter Notification
Template as necessary.

10. In the editor for adapter notifications, select the  SOPERA Generic Provider tab and specify
the following fields:

a. To create a one-way or request-response service provider:

DescriptionField

The name of the SOPERA service under which the specified
Integration Server service will be registered. For example:
{http://service.sopware.org/ExampleURI}ExampleService

SOPERA Service

The name of the operation in the specified SOPERA service. For
example: NotificationFS

SOPERA
Operation Name

Leave empty.Callback operation
name

Used only in the request-callback communication style.

Integration Server
Service

To use the SDX-first approach, specify the qualified name of the
IS service that will be generated.

Note:
In this case SOPERA Adapter creates both the IS service and
its corresponding IS document types.

To use the IS document-first approach, specify the qualified name
of the Integration Server service that will be exposed through the
SOPERA infrastructure. For example: test.string:concat

Note:
The input and output parameters of the specified Integration
Server service must be document references. The input
parameter is required, but the output parameter is optional. If
no output parameter is found, the adapter creates a ONEWAY
operation.

Use Existing
SOPERA Service

To use the SDX-first approach, select this check box to use an
existing SOPERA service specification.

The SOPERA service and operation will be loaded from the
SOPERA Service Registry. You can then select the service and
operation you require in the  SOPERA Service Name and
SOPERA Operation Name fields.

Important:
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DescriptionField

When this option is selected, the Integration Server servicewill
overwrite the current provider definition stored in the registry.

Do not selectwhen youwant to generate the SDX from an existing
IS document type.

In this case, youmust specify a name for the SOPERA service and
its operation in the  SOPERA Service Name and  SOPERA
Operation Name fields respectively.

Do not select.Is Req-callback
operation

Used only in the request-callback communication style.

Select this check box if you want to use HTTPS as the underlying
transport for this provider. TheHTTPandHTTPSports are configured

Use HTTPS

in the SOPERAAdapter configuration file. See “Set SOPERASpecific
Properties in the SOPERA Adapter Configuration File” on page 24
for details.

When selected, the service description will not contain any of the
data structure given in the signature.

Use Plain XML

Note:
Selecting this option works for services with one requestMessage
input parameter and one responseMessage output parameter, and
is recommended when conversion to IData is not necessary or
should be avoided for performance reasons.

b. To create a request-callback service provider, you specify the same values as for
request-response and one-way service providers, except for the following fields:

DescriptionField

Specify a callback operation that corresponds to the operation
specified in the Operation name field. For example, if the value in

Callback
Operation name

the Operation name field is inOut, the value in this field could be
inOutResponse.

Select this check box.Is Req-callback
operation

11. From the File menu, select Save.

SOPERA Notification Consumer
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You use the SOPERA Notification Consumer template to create service consumers when using
the SOPERA Notification communication style.

Note:SOPERAAdapter supports creating only one SOPERANotification Consumer for a given
SOPERA service using the same adapter connection.

To create a SOPERA Notification Consumer listener notification

1. Start Designer.

2. Right-click the package inwhich the notification should be contained and selectNew > Adapter
Notification.

3. Select the parent namespace and type a name for the adapter notification.

4. Click Next.

5. Select SOPERA Adapter as the adapter type and click Next.

6. Select the SOPERA Notification Consumer notification template and click Next.

7. Select the appropriate Notification Listener Name and click Next.

8. Click Finish.

Designer creates a listener notification and a publishable document type, and the editor for
the adapter notification appears.

9. In the editor for adapter notifications, select the Adapter Settings tab to confirm notification
properties such as the Adapter Name, Adapter Listener Name, and Adapter Notification
Template as necessary.

10. In the editor for adapter notifications, select the  SOPERA Notification Consumer tab and
specify the following fields:

DescriptionField

The name of the SOPERA service under which the specified Integration
Server service will be registered. For example:
{http://service.sopware.org/ExampleURI}ExampleService

SOPERA Service

The name of the operation in the specified SOPERA service. For example:
notify

SOPERA service
operation

The conditions under which the adapter service invokes a SOPERA
service. Policies are retrieved from the SOPERA Service Registry based

Policy

on the location configured in the Connection Settings. For information
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DescriptionField

about configuring the adapter connection settings, see “Configuring
Adapter Connections” on page 38.

Integration Server
Service

The qualified name of the IS service that will be generated. The
generated IS service has only an input parameter.

Leave empty, when the Publish IS Document check box is selected.

Publish IS
document

Select this check boxwhen youwant the service consumer to publish
an IS document.

Do not select when you want the service consumer to invoke an IS
service.

Input document
type

When Publish IS document is selected, provide a name for the IS
document type that will be generated. SOPERA Adapter generates
the specified IS document type and adds a reference to the IS
document in the publish document for the listener notification.

When Publish IS document is unselected, leave this field empty.

When selected, the response from the provider is returned as XML instead
of an IS document type.

Use plain XML

11. From the File menu, select Save.

Note:
When the template is saved, the existing flow service will be deleted and an empty flow
service will be created to match the signature of the service.

SOPERA Callback Consumer

You use the SOPERA Callback Consumer template to receive notification for the callback of a
request-callback service. For information about creating a request only adapter service, see
“Configuring Request-Callback Consumer Services” on page 51.

To create a SOPERA Callback Consumer listener notification

1. Start Designer.

2. Right-click the package inwhich the notification should be contained and selectNew > Adapter
Notification.

3. Select the parent namespace and type a name for the adapter notification.

4. Click Next.
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5. Select SOPERA Adapter as the adapter type and click Next.

6. Select the SOPERA Callback Consumer notification template and click Next.

7. Select the appropriate Notification Listener Name and click Next.

8. Click Finish.

Designer creates a listener notification and a publishable document type, and the editor for
the adapter notification appears.

9. In the editor for adapter notifications, select the Adapter Settings tab to confirm notification
properties such as the Adapter Name, Adapter Listener Name, and Adapter Notification
Template as necessary.

10. In the editor for adapter notifications, select the  SOPERA Callback Consumer tab and specify
the following fields:

DescriptionField

The name of the SOPERA service. For example:
{http://service.sopware.org/ExampleURI}ExampleService

SOPERA Service

The name of the operation in the specified SOPERA service. For example:
inOut

SOPERA service
operation

Changes automatically to a callback operation that corresponds to the
operation specified in the Operation name field. For example, if the

SOPERA service
callback operation

value in the Operation name field is inOut, the value in this field could
be inOutResponse.

The fully qualified document type name for the output IS document. For
example, doc.myservice.output:outDoc. SOPERAAdapter generates the

Output document
type

output IS document type and adds a reference to the IS document in the
listener notification publish document.

The conditions under which the adapter service invokes a SOPERA
service. Policies are retrieved from the SOPERA Service Registry based

Policy

on the location configured in the Connection Settings. For information
about configuring the adapter connection settings, see “Configuring
Adapter Connections” on page 38.

When selected, the service description will not contain any of the data
structure given in the signature.

Use plain XML

11. From the File menu, select Save.

SOPERA Request-Callback Provider
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You use the SOPERA Request-callback Provider template in one of the methods for creating a
request-callback provider. With this method you first create an adapter notification that receives
the request and publishes a document. Then using the SOPERACallback Sender Provider template,
you create an adapter service that sends a response to the request as described in “SOPERA
Callback Sender Provider” on page 55. The following procedure describes how to create a
request-callback provider listener notification.

To create a SOPERA request-callback provider listener notification

1. Start Designer.

2. Right-click the package inwhich the notification should be contained and selectNew > Adapter
Notification.

3. Select the parent namespace and type a name for the adapter notification.

4. Click Next.

5. Select SOPERA Adapter as the adapter type and click Next.

6. Select the SOPERA Request-callback Provider notification template and click Next.

7. Select the appropriate Notification Listener Name and click Next.

8. Click Finish.

Designer creates a listener notification and a publishable document type, and the editor for
the adapter notification appears.

9. In the editor for adapter notifications, select the Adapter Settings tab to confirm notification
properties such as the Adapter Name, Adapter Listener Name, and Adapter Notification
Template as necessary.

10. In the editor for adapter notifications, select the  SOPERA Request-callback Provider tab
and specify the following fields:

Note:
This type of listener notification supports only the SDX-first approach. As a result, the
services and their operations are populated on loading the listener notification.

DescriptionField

The name of the SOPERA service. For example:
{http://service.sopware.org/ExampleURI}ExampleService

SOPERA Service

The name of the operation in the specified SOPERA service. For example:
getUpper

SOPERA service
operation
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DescriptionField

The fully qualified document type name for the input IS document. For
example, doc.myservice.input:inDoc.

Input document
type

Important:
Specify a unique name for the input document type. If you specify an
existing document type name, the IS document type will not be
generated correctly.

Select this check box if you want to offer Integration Server services via
HTTPS. The HTTP and HTTPS ports are configured in the SOPERA

Use HTTPS

Adapter configuration file. See “Set SOPERA Specific Properties in the
SOPERA Adapter Configuration File” on page 24 for details.

11. From the File menu, select Save.

Enabling Listener Notifications
After you configure a listener notification, you need to enable it using Integration Server
Administrator.

To enable a listener notification

1. In Integration Server Administrator, select Adapters > SOPERA Adapter.

2. In the SOPERA Adapter menu, select Listener Notifications.

3. On the ListenerNotifications screen, clickNo in theEnabled column for the listener notification
you want to enable.

The Integration Server Administrator enables the listener notification and displays a Yes in
the Enabled column.

Testing Listener Notifications
You can test listener notifications to ensure that you have configured them correctly.

To test listener notifications

1. Configure a listener using Integration Server Administrator. For instructions to configure a
listener, see “Configuring Listeners” on page 62.

2. Configure a listener notification using Designer. For instructions to configure a notification,
see “Configuring Listener Notifications” on page 69.
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3. Enable the listener notification using Integration Server Administrator. For instructions to
enable a listener notification, see “Enabling Listener Notifications” on page 76.

4. Enable the listener using Integration Server Administrator. For instructions to enable a listener,
see “Enabling Listeners” on page 63.

5. On your SOPERA infrastructure, invoke the service registered when creating the listener
notification.

Viewing Listener Notifications
You use Integration Server Administrator or Designer to view listener notifications.

Viewing Listener Notifications Using Integration Server Administrator

To view listener notifications using Integration Server Administrator

1. In Integration Server Administrator, select Adapters > SOPERA Adapter.

2. In the SOPERA Adapter menu, select Listener Notifications.

The Listener Notifications screen appears, listing all the listener notifications.

Viewing Listener Notifications Using Designer

To view a listener notification using Designer

1. In Designer, expand the package and folder that contain the listener notification you want to
view.

2. Click the listener notification that you want to view.

Designer displays the configured listener notification in the adapter’s adapter notification
editor.

Editing Listener Notifications
You use Designer to edit listener notifications. When editing the listener notification, you can also
edit the publishable document type associated with the asynchronous listener notifications.

Listener notifications must be disabled before you can edit or delete them.

To edit a listener notification
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1. In Designer, expand the package and folder that contain the listener notification you want to
edit.

2. Select the listener notification you want to edit.

The adapter’s adapter notification editor displays details about the configured listener
notification.

3. Do one of the following:

If you have the VCS Integration feature enabled, right-click the notification and select
Check Out.

If you do not have the VCS Integration feature enabled, right-click the notification and
select Lock for Edit.

If you are using the local service development feature, from the Team menu in Designer,
select the appropriate option to check out the notification. The options available in the
Team menu depend on the VCS client that you use.

4. Modify the values for the listener notification’s parameters as needed. For detailed descriptions
of the listener notification’s parameters, see “Configuring Listener Notifications” on page 69.

Note:
Because listener notifications inherently depend on listeners, you cannot change a listener
for a listener notification after you configure it.

5. After you complete your modifications, save the notification and do one of the following:

If you have the VCS Integration feature enabled, right-click the notification and select
Check In. Enter a check-in comment and click OK.

If you do not have the VCS Integration feature enabled, right-click the notification and
select Unlock.

If you are using the local service development feature, from the Team menu in Designer,
select the appropriate option to check in the notification. The options available in the Team
menu depend on the VCS client that you use.

Deleting Listener Notifications
If you no longer want to use a particular SOPERA Adapter listener notification, you can delete it
by following the instructions in this section. You delete listener notifications using Designer.
Listener notifications must be disabled before you can edit or delete them.

To delete a listener notification

1. In Designer, expand the package and folder that contains the listener notification you want to
delete.
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2. Right-click the listener notification and click Delete.

Disabling Listener Notifications
You disable listener notifications using Integration Server Administrator.

To disable a listener notification

1. In Integration Server Administrator, select Adapters > SOPERA Adapter.

2. In the SOPERA Adapter menu, select Listener Notifications.

The Listener Notifications screen appears, listing all the listener notifications.

3. On the ListenerNotifications screen, clickYes in theEnabled column for the listener notification
you want to disable.

The listener notification becomes disabled and No displays in the Enabled column
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Calling SOPERA Services from Integration Server

Integration Server is registered as one of the participants of the SOPERA Service Backbone (SBB)
and it can invoke any service in the infrastructure that is provided by other SBB participants.
SOPERAAdapter creates an adapter service for Request-response, One-way, and Request-callback
services, which can be used in any Integration Server flows. SOPERAAdapter creates a notification
for the SOPERA notification style, which can be configured to perform any action on Integration
Server.

Calling Integration Server Services from the SOPERA
Infrastructure

You call Integration Server services from SOPERA when you want to:

Offer custom Integration Server services (implemented, for example, as flow or Java services)

Offer Integration Server adapter functionality

Implement existing SOPERA service specification

Offer built-in Integration Server services

Note:
Offering built-in Integration Server services is not recommended because built-in Integration
Server services are rather low-level, technical services.

Generating the Certificate for Secure Transport and Incoming
Call Authentication

When you want to expose any IS service using the HTTPS protocol or authenticate any incoming
calls, a keystore file should be used.

1. To export the certificate from Higgins, use this command:

> keytool -exportcert -keystore ./keystore.jks -alias client -file
mycert.certPassword: atleast8 (default)

2. To import the certificate into the client keystore, use this command:

> keytool -importcert -alias client -file mycert.cert -keystore keystore.jksPassword:
atleast8 (default)
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Adapter Logging Levels

SOPERAAdapter uses Integration Server logging mechanism to log messages. You can configure
and view Integration Server logs to monitor and troubleshoot SOPERA Adapter. For detailed
information about logging in Integration Server, including instructions for configuring and viewing
the different kinds of logs supported by the server, see the webMethods Audit Logging Guide for
your release.

Viewing the Logging Information for the Adapter

To access the adapter's logging information

1. From Integration Server Administrator screen, select Settings > Logging.

The Logging Settings screen appears. The Loggers section has Adapters included in the
Facility section.

2. Expand the Adapters tree to see a list of all installed adapters with their code number and
adapter description, along with the logging level.

Configuring Adapter Logging Levels
Beginning with Integration Server 7.1, you can configure different logging levels for SOPERA
Adapter.

To change logging settings for the adapter

1. From Integration Server Administrator screen, select Settings > Logging.

The Logging Settings screen appears.

2. From the Logging Settings screen, select Edit Logging Settings.

3. Select the required Level of logging for SOPERA Adapter.

4. Click Save Changes.

For complete information about specifying the amount and type of information to include in the
log, see the webMethods Audit Logging Guide for your release.

SOPERA Message Logging

You can also configure how the SBB Library generates logging output. The SOPERAAdapter SBB
Library uses the standard Java logging mechanism provided by the java.util.logging package.
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To enable logging for the Service Backbone, you must set the java.util.logging.config.file JVM
system property to point to a properties file that specifies the logging configuration for the SBB
library. For example:
-Djava.util.logging.config.file=mylogging.properties

If the java.util.logging.config.file system property is not defined, the LogManager reads its initial
configuration fromaproperties file located in the $<JAVA_DIR>/lib/logging.properties JREdirectory,
where $<JAVA_DIR> is the JAVA directory used by the Integration Server.

A sample configuration file can be located in your local SOPERA ServiceBackbone installation at:

SOPWare_directory/ServiceBackbone/work/components/org.sopware.SOPEngine/install/conf/logging.properties

For more information about how to configure Java logging, see the SOPERA installation and
operations guide and the Oracle documentation.

Adapter Message Logging

Integration Servermaintains several types of logs; however, SOPERAAdapter only logsmessages
to the audit, error, and server logs. Because SOPERA Adapter works in conjunction with the
WmART package, the adapter’s messages and exceptions typically appear within log messages
for the WmART package. The following table describes the type of messages SOPERA Adapter
logs into each type of Integration Server log:

DescriptionLog

You canmonitor individual adapter services using the audit log as youwould
audit any service in the Integration Server. The audit properties for an adapter

Audit

service are available in the SOPERA Adapter service template on the Audit
tab.

SOPERAAdapter automatically posts fatal-level and error-level logmessages
to the error log. These log messages appear as adapter run-time messages.

Error

SOPERA Adapter posts messages to the server log, depending on how the
server log is configured. Fatal-level through debug-level logmessages appear

Server

as adapter run-time logmessages. Trace-level logmessages appear as SOPERA
Adapter log messages.

The SOPERA Adapter’s log messages appear in the following format, ADA.0510.nnnnc, where:

ADA is the facility code that indicates that the message is from an adapter.

0510 is the SOPERAAdaptermajor code,which indicates that the error is generated by SOPERA
Adapter.

nnnn represents the error’s minor code. For detailed descriptions of the SOPERA Adapter’s
minor codes, see “ SOPERA Adapter Error Codes” on page 86.

c represents the message’s severity level (optional).
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Tomonitor SOPERAAdapter’s logmessages in the Server log, ensure that your server log’s logging
settings are configured to monitor the following facilities:

0113 Adapter Runtime (Managed Object)

0114 Adapter Runtime

0115 Adapter Runtime (Listener)

0116 Adapter Runtime (Notification)

0117 Adapter Runtime (Adapter Service)

0118 Adapter Runtime (Connection)

0121 Adapter Runtime (SCC Transaction Manager)

0126 Adapter Runtime (SCC Connection Manager)

SOPERA Adapter Exception Handling

If a SOPERA Adapter object (for example, a connection or service) encounters an error with the
SOPERA Infrastructure, it will throw an adapter error coupled with the SOPERA error, exactly
as it was thrown by the SOPERA infrastructure. For example, if an adapter service fails on the
SOPERA infrastructure at run time because the adapter failed to invoke a SOPERA service, you
will receive an adapter error. This error indicates that the adapter service failed, and the adapter
error will contain the specific error generated on the SOPERA infrastructure indicating why the
service failed.

SOPERA Adapter Error Codes

The following section lists the SOPERA Adapter's error codes and provides information on the
error message, reason, and possible action for each error.

DescriptionError Code

Unable to create the node document_name under package package_name. Ensure
that you have sufficient permission.

5502

Explanation: Error. Occurs when the adapter fails to create folders for document
generation.

Action:Make sure that you havewebMethods administrator privileges and sufficient
credentials. For information about setting user privileges, see the webMethods
Integration Server Administrator’s Guide.

Exception interfacing the Service Backbone.5555

Explanation: Error. Generic error that occurs during the handling of the SOPERA
Service Backbone library.
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DescriptionError Code

Action: Check the SOPERA infrastructure error in the logs to see the cause of the
exception and take appropriate action. If the problem persists, contact Software AG
Global Support.

Failed to release message handler for service IS_service_name.5556

Explanation: Error. Occurs when the adapter fails to release the message handler for
the specified Integration Server service.

Action: Check the SOPERA infrastructure error in the logs to see the cause of the
exception and take appropriate action. If the problem persists, contact Software AG
Global Support.

Failed to create service skeleton for service IS_service_name.5557

Explanation: Error. Occurs when the adapter fails to create the specified Integration
Server service as a SOPERA service.

Action: Check the SOPERA infrastructure error in the logs to see the cause of the
exception and take appropriate action. If the problem persists, contact Software AG
Global Support.

Unable to retrieve XML string from SOPERA incoming message.5558

Explanation: Error. Occurs when receiving an XML message from the SOPERA
infrastructure.

Action: Verify the input message to the adapter service or notification.

Unable to invoke IS service to satisfy SOPERA request. It might be that the service
does not adhere to the predefined signature (one input parameter incomingMessage
and one output parameter outgoing message).

5559

Explanation: Error. Occurs when the adapter fails to invoke an Integration Server
service in response to a request from the SOPERA infrastructure.

Action: Check the Integration Server error logs for the Integration Server service
invoked and verify the implementation of the Integration Server service.

Unable to produce outgoing message for SOPERA.5561

Explanation: Error. Occurs when the adapter fails to create a response message from
the Integration Server service invoked by the SOPERA infrastructure.

Action: Check the SOPERA infrastructure error in the logs to see the cause of the
exception and take appropriate action. If the problem persists, contact Software AG
Global Support.

Unable to send service response via SOPERA.5562

Explanation:
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DescriptionError Code

Explanation: Error. Occurs when the adapter fails to send an Integration Server
service response message to SOPERA.

Action: Check the SOPERA infrastructure error in the logs to see the cause of the
exception and take appropriate action. If the problem persists, contact Software AG
Global Support.

SBB error while invoking SOPERA service SOPERA_service_name operation
operation_namewith request message request_message_sent.

5563

Explanation: Error. Generic error that occurs when invoking an adapter service.

Action: Verify the values of the input parameters for the service. Check the SOPERA
infrastructure error in the logs to see the cause of the exception and take appropriate
action. If the problem persists, contact Software AG Global Support.

Error identifying how many attachments the response message contains.5564

Explanation: Error. Occurs when attempting to get the attachment count in the
response message in a RequestResponse Call or the
pub.wmsopera.service:getNonBlockingServiceResponse service.

Action: Check the SOPERA infrastructure error in the logs to see the cause of the
exception and take appropriate action. If the problem persists, contact Software AG
Global Support.

No message handler delivered.5567

Explanation: Error. No responseMessageHandler passed to the
pub.wmsopera.service:getNonBlockingServiceResponse service.

Action: Ensure that the message handler object is passed as input to the
pub.wmsopera.service:getNonBlockingServiceResponse service.

Error generating IS document document_name in package package_name. Errors:
error_text

5568

Explanation:

Explanation: Error. Occurs when the adapter fails to generate a document from a
SOPERA service. The value of error_text is null when no document is generated.

Action: Ensure that the correct folder name is appended to both the Input document
type and the Output document type.

Invalid value of document type. Either folder name or document type name is
missing in document_type_value

5569

Explanation: Error. Occurs when either the folder name or document type name is
missing from the value of the timeout parameter.
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DescriptionError Code

Action: Ensure that the document type value has folder name and document name
separated by ':'.

Unable to read and transform SOPERA request message into readable format for
the Integration Server service.

5570

Explanation: Error. Occurs when the adapter fails to read or transform a SOPERA
request message into an Integration Server service.

Action: Check the SOPERA infrastructure error in the logs to see the cause of the
exception and take appropriate action. If the problem persists, contact Software AG
Global Support.

Unable to instantiate Admin Facade at Admin_Facade_location.5571

Explanation: Error. Occurs when there is an error during the AdminFacade creation
when enabling an adapter connection or starting Integration Server.

Action:Verify the connection parameters in the SOPERAAdapter sopera.config file,
located in the Integration Server_directory \packages\ WmSoperaAdapter \config
directory. For information about the SOPERA Adapter configuration file, see
“Completing the Installation” on page 23.

Unable to instantiate ServiceBackbone.5572

Explanation:Error. Occurswhen there is an error during the ServiceBackbone creation
when enabling an adapter connection or starting Integration Server.

Action:Verify the connection parameters in the SOPERAAdapter sopera.config file,
located in the Integration Server_directory \packages\ WmSoperaAdapter \config
directory. For information about the SOPERA Adapter configuration file, see
“Completing the Installation” on page 23.

Unable to create/register the one-way service IS_service_name in the SOPERA
registry.

5601

Explanation: Error. Occurs when there is an issue during the creation or registration
of an Integration Server service as a one-way service in the SOPERA service registry.

Action: Check the AdminFacade error in the logs to see the cause of the exception
and take appropriate action. If the problem persists, contact Software AG Global
Support.

Unable to create/register the request-response service IS_service_name in the
SOPERA registry.

5602

Explanation: Error. Occurs when there is an issue during the creation or registration
of an Integration Server service as a request-response service in the SOPERA service
registry.
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DescriptionError Code

Action: Check the AdminFacade error in the logs to see the cause of the exception
and take appropriate action. If the problem persists, contact Software AG Global
Support.

Transport not enabled or port not configured.5603

Explanation: Error. Occurs when the transport port property is not configured
properly in the SOPERA Adapter configuration file.

Action:Configure the transport port property as required. For information about the
SOPERA Adapter configuration file, see “Completing the Installation” on page 23.

Unable to create/register provider for service: IS_service_name5604

Explanation: Error. Occurs for any error occur during the registration of a new
SOPERA service provider for the specified Integration Server service.

Action: Check the AdminFacade error in the logs to see the cause of the exception
and take appropriate action. If the problem persists, contact Software AG Global
Support.

Required parameters not provided for the notification.5605

Explanation: Error. Validation error for a notification in which required message
parameters are missing.

Action: Check all required parameters in the notification and set them as required.
For information about configuring adapter notifications, see “Configuring Listener
Notifications” on page 69.

Invalid SOPERA service name service_name found. The service name should be
of the format {<namespace_uri>}<service_name>.

5606

Explanation: Error. Occurs when an incorrect SOPERA service name is specified
while configuring the notification to invoke an Integration Server service via SOPERA.

Action: Check if the service name is specified in the following format and correct it
if it is not:
{<namespace_uri}<service_name>

Example:

{http://myservice.com/example} TestService

Errorwhile generating IS service/document service/document_name. Error error_text5607

Explanation: Error. Occurs while generating an empty Integration Server service or
document.
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DescriptionError Code

Action: Ensure that the IS service name or IS document name is a valid Integration
Server name and no other Integration Server service or document of the same name
exists.

IS document does not exist document_name. Enter an existing one.5608

Explanation:Error.Occurswhenyou attempt to create a SOPERAnotificationprovider
with a non-existing IS document.

Action: Ensure that the IS document exists onIntegration Server.

Error while retrieving the SOPERA service service_name from the registry.5573

Explanation: Error. Occurs when attempting to retrieve the specified adapter service
name instance from the registry name.

Action: Ensure that the service name is correct and the service is registered. See the
AdminFacade logs for the exact reason for the error.

Errorwhile processing input parameterswhile invoking SOPERA service service_name5574

Explanation: Error. Occurs when the adapter is unable to convert the input message
into XML or the request message is missing.

Action: Recreate the input document type for the specified service.

Fault message received - error encountered in service provider while invoking
SOPERA service.

5575

Explanation: Error. The exception occurs during the invocation of the SOPERA
provider service.

Action: Check the error logs at the SOPERA provider end.

SBB Error encountered when receiving non-blocking response from provider.5576

Explanation: Error. Occurs when the adapter is unable to get non-blocking response
from the pub.wmsopera.service:getNonBlockingServiceResponse service.

Action: Check the SOPERA infrastructure error in the logs to see the cause of the
exception and take appropriate action. If the problem persists, contact Software AG
Global Support.

Invalid value of timeout parameter.5577

Explanation: Error. Occurs when the value of the timeout parameter is not numeric.

Action: Verify the value of the timeout parameter passed in the
pub.wmsopera.service:getNonBlockingServiceResponse service.

Callback timeout. Increase timeout value.5578
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DescriptionError Code

Explanation: Error. Occurs when attempting to get a response for a Nonblocking
request.

Action: Increase the timeout value in the input parameter and retry. Also, ensure
that the provider has not thrown any error.

Configure local endpoint for service service_name and operation operation_name
and then restart all adapter connections.

5579

Explanation: Error. Local endpoint not found for the specified SOPERA callback
operation in the SOPERA infrastructure.

Action:Configure the local endpoint for the SOPERA callback service and the service
operation. Restart all adapter connections.

Authentication error invoking operation operation_name on service service_name
with subject user_credentials

5580

Explanation:Error. A SOPERAoutgoing call failed because of invalid user credentials.

Action: Ensure that the user who invoked the adapter service on Integration Server
has access to the specified SOPERA service on the SOPERA Infrastructure.
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Overview

This appendix describes the built-in services provided with the WmSoperaAdapter package of
webMethods SOPERA Adapter.

WmSoperaAdapter Package

TheWmSoperaAdapter package contains the public services used tomanage the SOPERA services.

pub.wmsopera.admin.adminService
Contains the package startup and shutdown services.

pub.wmsopera.service
Contains the utility services to manage the SOPERA services.

pub:wmsopera.service:getNonBlockingServiceResponse
Processes the returned request message handler, when the SOPERA service consumer adapter
service template is configured as a non-blocking request-response service.

Input Parameters

String Optional. The timeout, in milliseconds, specifies how long
to wait for a response message. Valid values are:

timeout

A negative value means wait forever.

0means return immediately regardless of whether themessage
has arrived. This is the default value.

String Optional. Valid values are:messageAsObject

true The response is returned as an Object.

false The response is returned as a String. This is the default
value.

Object The message handler returned from the SOPERA service
consumer adapter service template.

responseMessageHandler

Typically, you should use a flow service to map the
responseMessageHandler output value returned from the adapter
service to this parameter.
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Output Parameters

Object The response message as an Object, when the
messageAsObject input parameter is set to true.

responseMessageObject

StringThe responsemessage as a String,when themesssageAsObject
input parameter is set to false.

responseMessageString
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